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Summer is finally here! (For those of you 
in parts of California, Florida, and 
Arizona, and other parts of the US that 
experience great weather all the time, 
that’s the part of the year when it kinda 
stops being miserably cold, and bodily 
joints start working again.) What better 
way to celebrate this joyous period than 
a collation of the best tech that can help 
to make it an even better experience? 
Over on page 28 you’ll find a selection of 
awesome gear for the great outdoors, 
whether that’s relaxing in your back 
yard, hitting the open road, or heading to 
the great outdoors on your next vacation. 

We’ve also got something a lot of you have been asking about 
for some time now: a feature on helping you make the most of 
Apple Music, and to solve those niggling problems that prevent 
you from doing what you want with your tunes, whether it’s on a 
CD, in an old iTunes folder, or what have you. That’s over on page 
12, so head there now, and once you’ve had a good read let me 
know what you think. Did it solve your issue? If not, then drop me 
an email with your exact technical query, and I will collate each 
and every one, and send them over to our resident Apple guru to 
take a look at. I’ll then do a Q&A problem–solving roundup in a 
future issue, which will be a worthwhile read for those of you 
suffering with woes in the Apple media department.

On the main cover hit this issue — that’s the all–new Mac 
Studio and Studio Display. You’re probably excited to find out 
what we think about these new and intriguing Apple products. 
The Mac Studio is the first Mac to feature the brand new M1 Ultra 
chip, which is otherworldly powerful, but is it overkill for us mere 
mortals who were doing just fine on our regular M1 Macs? Do you 
even need a regular vanilla Mac Studio at all, or would a Mac mini 
suffice? And what of the Studio Display, Apple’s new 5K monitor 
for the “masses” (compared to the Pro Display XDR — $1500 
seems like good value versus $5000)? Find out what we think 
about them on page 38 and 42 with our in–depth ratings.

THINGS ARE WARMING UP >>>THE TEAM

Olivia Weaver
Production Editor

Olivia was quite green–

eyed watching her sister 

buy a brand new rose 

gold MacBook Air.

Matt Lochrie
Art Editor 

Matt found it tricky to put 

the Studio Display back in 

its box — hopefully a move 

customers won’t repeat…

NICK ODANTZIS, Editor

Twitter: @maclife

Editor’s opinion

Kenny Hemphill
Contributor

Kenny’s to–do list this 

issue was huge, but his 

roundup of the best to–do 

apps (p50) fixed that.
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Music & TV masterclass
Check out our info–packed feature on 

how to share your sounds, fix mangled 

metadata, and more. It’s time to 

transform your TV experience! 

Gear for the great outdoors
Flick over to page 28 for our top 

recommendations on the greatest tech 

for your travels. Come rain or shine, 

there’s a device to simplify your life. 

2812 66
Beginner’s Guides: Master 
Printing
Ah, printing...this irksome task becomes 

straightforward with our top tips — 

master it on your Mac, iPhone, or iPad. 
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I’ve been thinking about this 
with Apple’s current battles over 
the App Store, and the regulation 
it’s trying to avoid (or cooperate 
with unenthusiastically). This 
stubbornness could read like a 
modern version of Apple standing 
firm against Flash on iPhone, but 
there’s a key difference: Apple’s 
stance then was about defining the 
future, and the web not being 
controlled by the whims of a single 
company (Adobe). But this App 
Store battle isn’t like that. Here, 
Apple is the one looking 
backwards, protecting its existing 
revenue that the App Store’s 30% 
cut generates, and trying to be the 
one company to control access to 
the iPhone.

 Its refusal to budge in any truly 
meaningful way has meant that 
regulators are starting to step in, 
pushing Apple to support new 
options piecemeal, court loss by 
court loss. It already made Apple 
look out of touch to be fighting 
against such a clear changing 
of the wind’s direction.

On the day I write this, it’s 
been shown up by Microsoft, which 
has turned its sail fully into this 
new breeze. Microsoft has 
published a set of principles to 
define its approach to an app store 
going forward. Aside from 
promising to never promote its 

products above competitors or to 
use its data collection to advance 
its own products, it also promises 
that apps will be able to use any 
payment system they like, with 
free communication to customers.

Now, it’s easy for Microsoft to 
make sweeping commitments like 
this, since the Microsoft Store is 
not exactly the market leader. 
Should that matter? You might 
have said that about Apple in many 
of its principled stances. It’s easy 
to imagine Apple of the past 
having taken a leadership step like 
Microsoft here, so why won’t it 
now? Because it has too much to 
lose? Can’t we see that it’s going to 
lose it anyway? And if Apple can’t 
see that, isn’t that a worrying sign 
for where it’s skating to today?

O
VER THE TIME I’ve been 
following Apple, it’s always 
(ish) been skating to where 
the digital platform puck is 

going, even in ways that were 
controversial. Take its refusal to 
support Flash. It was a drawn–out 
battle of wills, but Apple not only 
prevailed, it was proved to have 
taken the more forward–thinking 
stance all along. In less 
controversial examples, it always 
wanted to remove DRM from the 
iTunes music store, and was one of 
the first stores to do so. It stood 
firm that its iTunes movies store 
should give free upgrades to higher 
qualities, which reportedly caused 
a rift between it and Disney — but 
Disney now offers its movies the 
way Apple wanted them. Even 
MobileMe was really a precursor to 
Google Suite and other cloud–
connected ecosystems. It just 
didn’t work very well. 

MATT BOLTON is worried that Apple’s 
stance on app store changes have meant 
that it’s become a follower, not a leader

> THE SHIFT

>>> Matt is the AV and smart home editor of Future’s flagship technology website T3 and has been charting changes at Apple since

his student days. He’s skeptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing.”

If Apple had just lowered its App Store cut, 
this whole developer battle might never 
have started. Hey ho.

Microsoft’s stance will turn its Store into the 
world’s foremost… no, I can’t even finish.
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Your opinions, rants & raves

I found the DAC article in the April 
issue (191) quite interesting, but 
one topic wasn’t addressed. I play 
music from my MacBook Pro via an 
HDMI cable to one of the HDMI 
ports on my AV receiver. I do this 
either from my older MacBook Pro, 
via a USB–C to HDMI adapter; or 
from my M1 MacBook Pro via its 
HDMI port. 

Would a DAC device make the 
sound better, or does my AV 
receiver take care of that? And are 
there DAC devices that take a 
signal from USB–C and output 
HDMI? Should I use an alternative 
input on the receiver? Thanks.
STEVE JOHGART

Thank you for your letter on this, 
Steve — others may be pondering 
similar questions, too. Cliff Joseph 
wrote this one for us, so we 
asked him for a response: 
“The issue with Macs is that 
the analogue sound quality 
that comes out via the 
3.5mm headphone socket is a bit 
poor — which is why you need a 
DAC to clean everything up. If Steve 
is using HDMI then he’s getting a 
nice, clean digital audio signal from 
the MacBook to his AV receiver — 
so he shouldn’t need a DAC at all.” 
Hopefully that clears up the 
question of whether you should lay 
down your money for a DAC.

Folder foibles
In your letter of the month in the 

February 2022 (189) issue, the 

reader hit the nail on the head. I 

am so tired of figuring out what 

has been doubled, tripled, or 

quadrupled in my music and 

photos. I get so angry that my 

folders in Music keep changing 

when I want to add a song list 

from the computer to the phone. 

I have to keep a backup of how I 

want my folders named. Then, I 

can move it into music in iTunes 

so it will add to my phone.

In short, if I want something to 

go to the cloud, then I wish it 

would ask me before 

automatically doing it. I am also 

worried about jumping ship on 

my iCloud service. If I knew for 

sure that when I back up to an 

external drive, that everything I 

need from the cloud is on there, 

then of course — I would not 

hesitate to jump ship to another 

cloud storage service.

How about grandfathering 

some of this functionality back 

into iTunes? It was much easier 

to organize on iTunes and send it 

back to your phone. Thanks to 

Stephen Santangelo for wording 

it in a way that makes sense.

WAYNE GUSTISON

IVOR, VIRGINIA

Older versions
In your February 2022 issue on 

page 28 (Mac time saver #11), 

you suggest that to tidy a 

desktop with many different 

kinds of items, one has to just 

Ctrl+click on the desktop and 

choose the “Use Stacks” option. 

This is supposed to neatly 

organize everything into stacks 

of similar kinds.

I am on macOS Sierra 10.12.6 

and this doesn’t work. According 

to another article, Stacks on the 

desktop only works in macOS 

Catalina 10.15. MacOS Mojave 

10.14 and older only get stacks to 

work in the dock. 

Perhaps you should mention 

exactly what macOS this item 

works in and whether there’s an 

alternative option.

ROBERT SPROULE

We always use the latest 

version of whatever operating 

system we are testing on, so in 

this instance it's Monterey for 

a Mac, for an iOS/iPadOS 

feature, it’s 15, and for Apple 

Watch it’s watchOS 7, and so 

on. That said, quite often the 

majority of tips included in 

these features will work on 

older versions, so they can still 

be really useful, even if you’re 

unable to upgrade.

Image rights: Apple, iFi audio.
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TV+ finally hits a home run
Apple’s streaming service on the rise as Netflix and CNN+ stall
BY ALEX SUMMERSBY

“for a limited time,” exclusively on 
Apple TV+. Fans also get on–demand 
replays, recaps, daily coverage, and 
additional exclusive content. 

While Apple TV+ is expanding, the 
growth of Netflix has stalled in an 
unusual turn of events. It is still 
market leader, with more than 220m 
subscribers, but it announced that it 
lost 200,000 subscribers in Q1 2022, 
its first decline in growth in more 
than a decade. It also said it expects 
to lose two million more in the next 
quarter as users cut back their 
spending as a result of the global 
cost–of–living crunch.

T
HE STREAMING MARKET is 
facing a shakeup as Netflix 
slumps while Apple TV+ grows.
At the 94th annual Academy 

Awards in March, CODA won the 
Oscar for Best Picture — the first 
time this award has ever gone to a 
movie released by a streaming 
service, not in theaters. (Afterwards, 
however, Apple rereleased CODA for 
a limited run in over 600 US movie 
theaters, no doubt to help recoup the 
record $25m it paid for worldwide 
streaming rights to the movie.)

Since the launch of Apple TV+ in 
November 2019, Apple’s original 
series and feature films have won 
many awards — 953 nominations 
and 240 wins, to be exact — but the 
milestone Oscar win gave Apple TV+ 
a significant boost. Variety reported 
that views of the movie were up 
more than 300% from the week 
before and new viewers up 25%. 
(Apple does not release figures, but 
industry observers estimate that 
Apple TV+ has roughly 50m global 
accounts and 25m paid subscribers. 
One analyst said the Oscar could 
mean an extra 10m paid subscribers.)

Adding to the momentum is the 
launch of Friday Night Baseball and 
related programming in association 
with Major League Baseball. MLB 
scheduled games are available to all 
with internet access, free of charge 

Image rights: Apple.

Netflix admitted its decision to 
raise prices had cost it 600,000 
subscribers in North America alone, 
on top of 700,000 lost when it quit 
Russia over the invasion of Ukraine.

Revenue was still up almost 10% 
year–on–year, but profit fell by 6%. 
Netflix shares plummeted, wiping 
more than $50 billion off its value.

Unrelatedly, CNN shut down its 
CNN+ news streaming service just a 
month after its launch. Its newly–
merged parent company, 
WarnerBros. Discovery, is billions in 
debt and could not undertake to fund 
it until it reached profitability.

8   JUN 2022
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M2 Macs coming?

iMovie updated
Video creation made even easier for newbies

WHEN IT INTRODUCED its latest 

chip, the M1 Ultra used in the Mac 

Studio, Apple explicitly stated that this 

completes the M1 lineup. Will new Mac 

models from here on have a newer 

chip inside? Apple has reportedly 

begun testing of “at least nine” new 

Mac models with next–generation M2 

processors, including:

> MacBook Air, Mac mini, and MacBook 

Pro models powered by an M2 chip 

with eight CPU cores and 10 graphics 

cores (compared to eight graphics 

cores in the current MacBook Air);

> 14–inch and 16–inch MacBook Pro 

models with M2 Pro and M2 Max 

chips, the latter with 12 CPU cores and 

38 graphics cores (compared to 10 

CPU cores and 32 graphics cores in 

the current model);

> A new Mac Pro with M2 Ultra chip.

Two or more new models could be 

announced as soon as June, at Apple’s 

Worldwide Developer Conference.

APPLE HAS RELEASED iMovie 3.0 

for iPhone and iPad with new 

beginner–friendly features: 

Storyboards and Magic Movie. 

Storyboards help novice creators 

get started. Instead of starting with a 

blank timeline, they can choose from 

20 templates for popular video types 

including cooking tutorials, Q&As, 

news reports, and more. Each 

storyboard has a guide shot list and 

step–by–step advice on which clips to 

capture for each video type. Shots can 

be added, reordered, and deleted as 

needed. Titles, transitions, and filters 

can be added and customized. Music 

tracks dynamically adjust to fit the 

length of a project, and users can 

refine each clip with intuitive editing 

tools like trim, split, clip speed, and 

clip volume.

For even faster results, Magic Movie 

instantly creates a polished video for 

you — simply select an album or any 

group of photos or images from your 

library, and Magic Movie identifies 

the best bits and creates the project, 

automatically adding transitions, 

effects, and music. You can then 

rearrange or delete clips in the 

simplified Magic Movie shot list, or 

edit the project further.

Finished Storyboard videos and 

Magic Movies can be shared from 

iMovie via Messages, Mail, and on 

social media.

iMovie 3.0 is a free upgrade and 

requires iOS 15.2 or iPadOS 15.2.

News in 
brief
A bite of the Apple

> iWORK APPS UPDATED

Apple has released Pages 12.0, 

Numbers 12.0, and Keynote 12.0 for 

Mac, iPad, and iPhone. All are free 

updates. Even though this is a new 

whole–number version, there are 

nowhere near as many new features 

as in version 11.2 of these apps six 

months ago.

> On Mac, you can now use Shortcuts 

on macOS Monterey to create or 

open documents in all three apps, 

and to add rows to a table in Numbers 

or start presenting in Keynote. 

> On iOS and iPadOS, you can now 

edit font size more precisely (up to 

two decimal places) in all three apps.

> On all platforms, you can use 

VoiceOver to read comments and 

track changes in Pages 12.0, or create 

formulas and autofill cells in Numbers 

12.0. It is also possible to publish 

directly from Pages 12.0 to Apple 

Books with larger file sizes of up to 

2GB on all platforms. There are a few 

other new features, detailed in 

Apple’s support pages.

> NEW 35W DUAL–USB ADAPTER?

Apple is said to be bringing out a new 

35W power adapter with fold–away 

prongs and dual USB–C ports. 35W 

would be suitable for charging a wide 

range of devices, from iPads to the 

latest MacBook Air. The design could 

be similar to this 20W adapter with 

folding prongs Apple sells in the UK.

Image rights: Apple. JUN 2022   9
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>>> A great speaker doesn’t just sound 

incredible, it looks so good that it 

becomes the centerpiece of any room it 

occupies. That’s the case with the Sonus 

Faber Omnia, a sleekly gorgeous speaker 

that exudes class from every angle.

Its audio performance is simply 

sensational, with superb clarity, satisfying 

bass, and a wide soundstage all on offer. 

Never mind stereo speakers, the Omnia 

proves you don’t have to sacrifice quality 

if you want the convenience of a single–

speaker setup.

We also love its flexibility. There are 

heaps of wireless options, from AirPlay to 

Chromecast, plus built–in support for 

Spotify and Tidal. And if you prefer a 

wired connection, you’re well served 

there too. In other words, the Sonus Faber 

Omnia is an exemplary wireless speaker 

that won’t disappoint.

Sonus Faber 
Omnia

$1,999 From sonusfaber.com

>>> As far as games consoles go, the 

Nintendo Entertainment System (NES) is 

up there in the pantheon of gaming gods. 

It’s therefore unsurprising that there is a 

whole cottage industry of tributes to the 

device, but few are as downright cool as 

the Love Hultén NES–SY37.

On the surface, it’s a conceptual 

synthesizer that lets you create deeply 

nostalgic tracks based on the sounds 

found in classic NES games. That alone 

makes it a great way to reconnect with 

the past and relive days gone by.

Built into the device is a MIDI visualizer 

display. In a clever twist, the NES–SY37 

accepts NES cartridges, meaning you can 

play old–school games on the screen as 

well as create music inspired by them. If 

you’re passionate about retro games and 

music, it’s perfect.

Love Hultén NES–SY37 

$TBC From lovehulten.com

Start>>>
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>>> Robotic vacuum cleaners might not 

be here to take over the world, but they 

certainly keep your house tidy. But the 

problem comes when their job is done: 

emptying them can inadvertently cause 

as much mess as you wanted to clean up.

Roidmi’s Eva could put an end to that. 

It’s a self–cleaning and emptying robo–

vacuum that scores another point for 

robot sentience (and spotless homes). Its 

housing contains two water tanks that 

clean the robot, before fans buzz up to 

quickly dry it off.

As for what the bot itself can do — it 

comes with three modes for vacuuming, 

mopping, or a combination of the two. It’ll 

reach into crevices and can hold 60 days’ 

worth of dust. So, if you’re sick of doing 

all the work yourself, send this little bot 

on its merry way.

>>> Even if you consider yourself an 

excellent multitasker, managing different 

audio inputs at the same time can be 

particularly tricky. The Genki Waveform 

earphones are a step in the right 

direction, though, as they work with two 

audio streams simultaneously.

Although it was built with gaming and 

multitasking in mind, Waveform works 

with a huge range of products. You could 

use a games console while taking a phone 

call from your iPhone, or listen to a 

lecture on your Mac while concurrently 

playing some ambient music from your 

iPad, for instance.

It’s not just a gimmick either, as it 

boasts aptX compatibility, Bluetooth 5.2, 

24–bit audio, and 30 hours of battery life. 

It could be a great addition to your setup, 

work or play.

>>> As more people get electric cars, the problem 

of how to charge them at home gets ever more 

prevalent. Right now, most options involve a 

charging cord snaking its way along the floor.

Fortunately, Continental thinks it has a better 

idea. It’s working on an as–yet–unnamed charging 

robot that automatically juices up your vehicle 

without the hassle of traditional systems. 

All you need to do is place the robot on your 

garage floor. There’s no need to manually plug in a 

lengthy cable every time your vehicle needs 

charging, just park your car over the robot and it’ll 

get to work.

Genki Waveform 
$279 From genkithings.com

Roidmi Eva 

$999 From roidmi.com

Continental 
electric vehicle 

charging robot 
$TBC From continental.com

The gear we’re lusting after
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 B
ack in 2001 — yes folks, 21 

years ago — Apple urged us 

to Think Different about 

music. That year’s iMac included a 

brand new bit of hardware, a CD drive 

that could also burn CDs whose 

contents were picked by you from 

your music library. That Mac came 

with a new slogan — Rip. Mix. Burn 

— and it was soon followed by 

something Apple called the iPod. 

That turned out to be quite a big deal.

To begin with, Apple thought 

we’d copy CDs to our hard disks and 

to our iPods. But, as internet 

connections got faster and storage 

space got cheaper, Apple moved to 

selling downloads with the iTunes 

Music Store in 2003, adding TV 

shows and movies in 2006. It began 

phasing out optical drives in Macs 

with the MacBook Air in 2008, and in 

2015 it launched the Apple Music 

streaming service; Apple TV+ 

followed in 2019. Apple still sells 

digital downloads, but it would  

much rather you took out a 

streaming subscription.

As much as we love streaming, 

we have existing libraries of music 

and video from the days when iMacs 

could still rip, mix, and burn. In this 

feature, we’ll discover how your 

existing libraries can live with Apple’s 

newer services in perfect harmony. 

We’ll also discover what pitfalls to 

watch out for, how to get the most 

music and movie bang for your 

subscription buck, and what to do 

when you encounter problems 

with media in your library.

Image rights: Apple.

Sharing your sounds, 
fixing mangled metadata 
and transforming your 
TV experience couldn’t 
be easier
WRITTEN BY CARRIE MARSHALL
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How to import and 
manage your own 
Music collection

RIP. 
MIX.  
BURN.

1See all your stuff
Your existing library should now 

appear in the Artists, Albums, Songs, and 

Music Videos sections. As you can see, the 

interface is identical to Apple Music, and if 

the artist has included lyrics in their MP3s, 

you can sing along.

2Smart Playlists
Smart Playlists enable you to create 

constantly updated playlists based on 

whatever rules you add. Go to File > New > 

Smart Playlist and select one or more 

rules to filter your music. We’re going for 

low–key tunes we’ve clicked Love on.

3Restore ratings
Apple clearly wants to get rid of star 

ratings in favor of more basic love/dislike 

choices, but you can bring them back: click 

Songs in the sidebar then go to View > 

Show View Options > Rating to see and 

add star ratings out of five.

HOW TO Get the best from the Music app

Image rights: Apple.

AS LOVELY AS it is to have an extensive 

collection of CDs, you can’t beat the 

convenience of digital music. The first 

iPod promised 1,000 songs in your pocket 

and today’s iPod touch or iPhone has 

room for more music than most of us buy 

in a lifetime, with Macs offering even 

more. So how do you get your CDs into 

the Apple Music app, or iTunes on older 

Macs, so you can play them, share them, 

and even burn your own CDs from them?

The good news is it’s really simple; if 

you have a CD/DVD drive in your Mac just 

put the CD in the drive and your Music 

app will look it up online and find the 

title, track details, and artwork. If your 

Mac doesn’t have a CD/DVD drive you 

can attach one via USB. Apple still makes 

the USB SuperDrive, a CD/DVD player 

and burner, and there are plenty of more 

affordable third–party options too.

Before you start to import, it’s worth 

taking a trip into the Music app’s settings 

(in Music > Preferences). If you have an 

internal CD/DVD drive or have connected 

an external one you should see an option 

in the General tab for “When a CD is 

inserted”. You can choose between Show 

CD, which displays the disc in Music but 

doesn’t play it; Play CD, which does what 

you’d expect; Import CD, which 

automatically copies the whole CD to 

your Library; and Import CD and Eject. 

This last option is best if you’re going to 

be importing multiple discs.

In Preferences, click on Files and 

ensure “Keep Music Media folder 

organized” and “Copy files To Music 

Media folder” are both checkmarked. 

This means your music always goes to 

the same place on your Mac, or on an 

external drive if you’re short of storage. 

If you have multiple users on your Mac 

you should do this on their accounts too, 

ensuring that the location of their media 

folder is under their own user account — /

Macintosh HD/Users/[their username]/

Music. This ensures that everybody’s 
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Sometimes Music’s data for ripped 

songs and albums can be incorrect. A 

song might be assigned to a 

compilation album rather than the 

original LP, or it might have the 

Japanese artwork rather than the US 

version, or if there’s a featured artist 

involved — the song may be listed as 

a separate artist to the artist whose 

record it is. There are several 

automatic ways to fix this; we 

particularly like Doug’s Apple Scripts 

at dougscripts.com and the 

MusicBrainz Picard app from picard.

musicbrainz.org. Both make it very 

easy to find and fix dodgy Music data.

Image rights: Coppertino Inc, iina.io, Ismael Carrea & Jonas Kvinge, digipine.com, Audiofile Engineering, MusicBrainz Team.

MusicBrainz Picard compares your tracks 
with a massive online database of music.

music is stored separately. You can all 

share the same storage location if you 

prefer; once you’ve got your Library on 

one account, open another and in Music 

use File > Import. 

Next, click Import Settings. This is 

where you decide what file format and 

file quality your music will be when it’s 

copied to your library. The default is 

Apple’s AAC format, which is designed 

for mobile music; it’s not full quality but 

it’s hard to tell the difference on ordinary 

earbuds and the file sizes are fairly small. 

Apple Lossless is our pick, as it stores 

the music without removing any of its 

musical information. That means you get 

the full audio experience without any loss 

of quality. If you want that but also want 

to make your files compatible with music 

apps, you can choose AIFF or WAV 

instead. They’re lossless formats too, but 

they’re less efficient than Apple Lossless 

so the files require a bit more space.

PINE PLAYER

From digipine.com

If you’re looking for a capable 

player for very high–res audio 

tracks, Pine Player is definitely 

worth a look. The third–party 

app has wide format support 

including DSD and offers 

excellent upsampling too.

IINA

From iina.io

Although designed primarily for 

video (see p24), IINA also has a 

Music Mode that makes it an 

attractive if quite simple music 

player. It’s only available for 

macOS 10.11 or later and macOS 

10.15 (Catalina) is recommended.

VOX

From vox.rocks/ 

mac-music-player 

Available for both Mac and iOS 

devices, Vox is a hi–res audio 

player that looks as good as it 

sounds. The core app is free but 

advanced settings will require a 

paid subscription.

STRAWBERRY

From strawberry 

musicplayer.org 

This open source music player 

for Mac, Linux, and Windows 

looks like iTunes used to, but 

fortunately the underlying tech 

is not dated. It’s also a great 

music manager and tagger.

FIDELIA

From audiofile. 

engineering/fidelia

Remember when music apps 

looked like music hardware? 

Fidelia does. It’s gorgeous, and 

it sounds great thanks to 

support for all the key music 

formats as well as plug–ins.

> �Alternatives 
to the Apple 
Music app

The Music app is good at 
what it does, but if 
you’re looking for 
something a bit different 
you’re spoilt for choice. 
These players offer 
things Music doesn’t, 
such as support for 
more formats and more 
streamlined interfaces.

FIX YOUR MUSIC LIBRARY 

Once you’ve got your settings ready, 

look at the CD in your Music app and 

check that the details you see on screen 

are correct: is the artwork okay? Are the 

song titles correct? You can change this 

afterwards on individual tracks or albums 

by selecting them, Ctrl–clicking and 

choosing Get Info, or with a third–party 

fixer (see “Fix Your Music Library – Fast”), 

but it’s better to get it right first time. 
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QUICK LOOK iCloud Music Library

Image rights: Apple.

THAT SYNCING 
FEELING…
If you don’t have Apple Music or iTunes 

Match, enable Wi–Fi syncing from your 

Mac by connecting your device via its 

USB/Lightning cable and selecting it in 

the Finder. Now choose “Show this 

device when on Wi–Fi” to enable Wi–Fi 

syncing. If you get connection errors 

with cables make sure your software is 

up to date and try connecting without 

any USB hub in the middle; if that 

doesn’t work, try a different cable. 

CATEGORIES
Here, you can quickly 
jump to recently 
added songs or 
select the artists, 
albums, songs, and 
videos categories.

MORE 
OPTIONS
Click here to remove 
the download, view it 
in the Finder, and 
access additional 
options too.

DOWNLOADING
An incomplete circle 
shows you how much 
of the track has been 
downloaded so far 
(it’s also the same 
on an iOS device).

LOVED ICON
These days Apple 
would rather you 
simply select Love 
for a song than give 
it your own rating 
out of 5.

DOWNLOAD 
STATUS
A check mark means 
the album is stored 
locally; this icon 
means the album is 
now downloading.

TRACK 
STATUS
If you can’t see the 
solid arrow icon, 
Ctrl–click the three 
dots to download 
the song.

How to manage your iCloud Music Library

UPLOAD.  
DOWNLOAD. SYNC.

FOR THOSE WITH an Apple Music 

subscription, you can actually access 

your local music from any device if it’s 

logged in with your Apple ID. The iCloud 

Music Library will even store up to 

100,000 songs — and it doesn’t matter 

whether you ripped them or bought them 

from iTunes. 

However, there’s another way to 

get the benefits of that feature without 

actually paying a subscription to Apple 

Music. For $25 per year, iTunes Match can 

copy all your music to the cloud and if it 

has a higher quality version of a song it 

replaces your one with that one. iTunes 

Match is limited to 25,000 songs. 
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4Sync devices
We haven’t played anything on our 

iPhone yet, but as you can see there are 

already records in our Recently Played 

section of the Music app. That’s exactly 

what we want; it means the syncing is 

working between Mac and iPhone.

1Check settings
When you join Apple Music or iTunes 

Match, the iTunes or Music app should 

automatically add a Sync Library option to 

the app’s Preferences > General section. 

Make sure that option is checked or your 

songs won’t sync.

7Look for errors
These are the icons to worry about: 

Ineligible typically means the song is too 

big (over 200MB), poor quality (96kbps or 

less) or too long (over 2 hours). You’ll need 

to convert the file with an external app 

before iCloud will accept it.

5Make a Match
If you don’t have Apple Music you 

can still take advantage of iCloud Music 

Library, for now at least… iTunes Match 

is $25 a year and you can subscribe 

by going into the iTunes Store in either the 

iTunes or Music apps.

2Check on mobile
On iPhone, iPad, and iPod touch the 

same setting lives in the Settings app’s 

Music section. Once again Sync Library 

should be toggled on, but you can turn 

it off if for whatever reason you don’t 

want to include this device.

8Watch this space
Streaming from iCloud to your 

Apple Watch is brilliant, because it handily 

solves the problem of the Watch’s limited 

storage space. As you can see, the Apple 

Watch app carries across your music 

ratings from your other devices.

9Tame your tunes
The Apple Watch interface is 

deliberately simple, but you can still 

use it to add or remove tracks to and from 

playlists, to mark them as Loved or to 

tell Apple Music to suggest less songs 

like the current one.

6Know the code
Apple uses little status icons in the 

Library listings to show how your upload is 

doing. iTunes Match and Apple Music 

won’t upload duplicates of the same song; 

the cloud with an arrow means the song 

will stream but isn’t downloaded.

3Decide on data
On your iPhone there’s another 

option to think about: “Download over 

Mobile Data”. Unless you have an 

unlimited data plan, switch this 

option off when you first upload 

your entire library to Apple’s cloud.

HOW TO Sync and share iCloud Music Library
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One of the best things about Apple Music is  
Spatial Audio, where tracks are mixed in 3D. 

As a test case, we decided to defect 

from Spotify and go all in on Apple. 

Before we quit Spotify we 

transferred our favorite playlists to 

Apple Music using the Free Your 

Music app (freeyourmusic.com). 

The Mac app didn’t work for us but 

on iOS it was fast and effective; we 

logged in with Spotify and with 

Apple Music, picked our playlists 

and transferred them across. It’s 

free for up to 100 songs; for any 

more, or to copy albums, you’ll 

need to pay for a premium account. 

That costs $10.99 for a month’s 

access but if you’re a long–time 

playlist maker it’ll save you many 

hours — so it’s worth it.

HOW TO SWITCH BETWEEN  
STREAMING SERVICES

AMAZON MUSIC 

UNLIMITED

From music.amazon.com

It doesn’t have as many songs, 

but Amazon Music is cheap. Its 

one–Echo plan, which limits you 

to one Echo or Fire device, is 

just $3.99/month. The normal 

service is $7.99/month.

TIDAL

From tidal.com

Founded (but no longer owned) 

by rap superstar Jay–Z, and with 

over 80 million tracks, TIDAL 

is one of the best streaming 

services for hi–res audio tracks, 

as well as other standard 

resolution streaming options. 

SPOTIFY

From open.spotify.com

You can’t knock Spotify’s 

usability; thanks to Spotify 

Connect it works with almost 

anything. However controversies 

over its podcast division and its 

very low royalties mean some 

artists are now boycotting it.

DEEZER

From deezer.com

Deezer is a very big deal in 

mainland Europe thanks to a 

winning combination of great 

apps and a very large catalog of 

music. It boasts over 90 million 

audio offerings and its 

recommendations are good.

QOBUZ

From qobuz.com

Qobuz isn’t exactly a household 

name just yet but it’s well known 

in hi–res audio and audophile 

circles thanks to its world–

beating catalog of high–

resolution audio files for a 

reasonably low monthly price.

> Streaming 
alternatives 
to Apple Music

If you’re all–in on Apple 
devices, we think Apple 
Music is far and away 
the best option thanks to 
its excellent device and 
Siri integration. But not 
everybody has an Apple–
only home, and rival 
services may provide a 
better option.

The pros and cons of 
subscribing to the  
Apple Music app

SUBSCRIBE. STREAM. INDULGE.

APPLE MUSIC HAS two big advantages 

over rival streaming services: Apple 

Lossless and Spatial Audio. The former 

delivers CD–quality streaming instead of 

the compressed music some other 

services deliver, and Spatial Audio 

delivers a three–dimensional effect that 

can make you feel you’re right there in 

the studio with the artist. It’s particularly 

good on AirPods Pro and Max.

Apple Music is $9.99/month or $4.99/

month for the Voice Plan, which is only 

controllable via Siri. Apple Music is also 

included in every Apple One subscription. 

Every family member has their own 

playlists and preferences, and if you have 

HomePod minis they can recognize 

voices and use the appropriate account.

The downside is: if you stop paying, it 

stops playing. The music you’re listening 

to, with the exception of your own library 

tracks that have been uploaded to the 

iCloud Music Library, is only rented. You 

might also find that, as with other 

streaming providers, tracks may be 

removed from the service: for example, 

some artists are currently in dispute with 

the Apple Music rival Spotify and have 

pulled their music. The solution? Stream 

everything but buy the legal downloads 

or CDs of the artists you want to support 

and the music you want to keep.
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4Pick a playlist
The Music app doesn’t differentiate 

between Apple Music tracks and your own 

songs when you create or edit your 

playlists, although if you stop subscribing 

you won’t be able to play any of the Apple 

Music tracks.

1Take a look
You can sign up for Apple Music in 

Music on your Mac or iOS/iPadOS device. 

Here, we’ll look at the full Apple Music 

service; there’s a voice–only version for 

Siri devices too. Once you’ve signed up, 

Apple Music appears in the app.

7Sing along
Apple Music also has the lyrics to 

many songs. To display them either click 

on the speech bubble icon next to the 

AirPlay one or click View > Show Lyrics. 

The lyrics scroll as the song progresses so 

you can follow along.

5Save for later
By default, Apple Music streams all 

of its music via the cloud. If you want to 

download a song, for example because 

you’re going somewhere you can’t get 

internet access, you can download it 

by clicking the down arrow icon.

2Play something
If you click on the Browse link you’ll 

see a range of curated playlists to give 

you something to listen to. Opening a 

playlist looks and works just like it did 

in iTunes, and as it does with your own 

music library too.

8Listen to Radio
Apple Music also includes tons of 

streaming radio stations, organized by 

genre and featuring a lot of big names 

from the world of music and beyond. It 

also creates custom stations based on the 

music you’ve been listening to.

9Get the good stuff
Is the station playing something new 

that you like? Click on the track name 

while Apple Music Radio is playing it and 

you’ll see the same options that you get 

with other Apple Music tracks, so you can 

love, save, or share the song. 

6AirPlay it anywhere
If you have AirPlay devices, you 

can send your music to one or more of 

them by clicking the AirPlay icon at the 

top right of the window. This brings up 

a list of available devices; simply select the 

one(s) you want.

3Find a keeper
If you discover something you 

really like, clicking on the “…” on the right 

enables you to do multiple things: love 

it, create a station based on that kind 

of music, add it to your library, share 

it or add it to a playlist.

HOW TO Get started with Apple Music
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QUICK LOOK The iTunes Store explained

NEW RELEASES
This strip and the carousel above showcase 
the latest big hitters that have been added.

GENRE FILTER
Only interested in German nosebleed techno? 
No problem! You can filter the Store by genre.

ACCOUNT DETAILS
This is where you can redeem gift cards, check 
your account details, and get support.

Master the options 
available to you in the 
iTunes Store

BUY. 
DOWNLOAD. 
ENJOY.

FOR THOSE WHO want to own their 

music rather than rent it, the iTunes 

Store is your friend. But it’s wise to 

ensure you download (and backup, with 

Time Machine) everything you buy: if 

something is removed from the Store, 

it’s gone and you can’t re–download it. 

Purchases are associated with the Apple 

ID that bought them, so if you have 

multiple Apple IDs you won’t see your 

other IDs’ purchases. If you have Music or 

iTunes and haven’t checkmarked View > 

All Music you won’t see any purchases 

you haven’t downloaded. And if you 

delete or hide music from one of your 

devices, it’ll disappear from your other 

ones too. To unhide purchased tracks, go 

into Music on your Mac and click iTunes 

Store > Account > Downloads and 

Purchases > Hidden Purchases > Manage. 

If the iTunes link is not there, enable it in 

Music > Preferences > General > Show > 

iTunes Store.
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QUICK LOOK The iTunes Store explained

SPECIAL FEATURES
View Spatial Audio tracks or Apple’s cloud 
services Apple Music and iTunes Match.

TOP SONGS
These are the best–selling songs on the iTunes 
Store right now and are usually by Ed Sheeran.

HISTORY AND TIPS
See what you’ve already bought and get some 
suggestions for some more things to buy.
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Apple is spending big on TV and movies. The 
current Apple TV+ line–up is very impressive.

QUICK LOOK The Apple TV interface explained

HOME PAGE
This displays your 
viewing options. 
Unlike on the Apple 
TV HD and 4K, the 
Mac app only shows 
Apple TV+ content.

STORE
This is where the 
iTunes movie and TV 
store currently lives, 
with the option for 
you to buy or rent 
available titles.

SEARCH
Type here and the 
search field enables 
you to search your 
Library, the iTunes 
Store, and Apple TV+ 
for content.

UP NEXT
Here is your to–
watch queue. You 
can add shows in 
the app by Ctrl–
clicking and choosing 
Add To Up Next.

APPLE TV+
This button takes you 
to Apple’s own  
TV+ streaming 
service where you 
can stream or 
download content.

LIBRARY
This area is where 
your own library of 
any downloaded 
movies and TV shows 
lives now iTunes is 
no more. 

How the TV app makes it easy to stream shows

WATCH WITH MAC  
(AND YOUR OTHER DEVICES)

UNTIL VERY RECENTLY, buying digital 

content limited what you could do with it 

and what devices you could watch it on. 

And you could forget about converting it 

to make it more suitable for your phone. 

Now, the Apple TV app makes it easy to 

share your content and your Apple TV+ 

subscription with all your devices.

You can use an Apple TV to stream 

your home videos from iCloud, or from 

your Mac via Home Sharing (Settings > 

Users and Accounts > Home Sharing on 

Apple TV and System Prefs > Sharing on 

Mac). Home Sharing works with Windows 

PCs. Your Apple TV and the source Mac 

or PC need to be on the same Apple ID.

22   JUN 2022

>>> Music & TV masterclass



4Look in the Library
The Library automatically 

organizes your movies and shows by 
genre and also creates some quick links 
so you can look for features such as 4K 
HDR content. It also tells you how much 
space your library is using.

1Click to stream
Apple TV+ makes it easy to start 

watching selected content. Once you’ve 

found what you want, click Play First 

Episode to start streaming. Apple TV 

can stream in 4K; Apple recommends 

a 25Mbps internet connection for this.

5Explore the episodes
For TV programmes, the Library 

organizes them by show and series/
season. Clicking on the name of a show 
with more than one downloaded 
episode will open it up so you can see 
the synopsis of each individual one.

2AirPlay your show
Want to watch content on the big 

screen? No problem. Click the AirPlay 
icon at the bottom left corner and you’ll 
see a list of compatible devices you can 
stream to — so, in this case, we’d select 
Samsung Q60, which is our TV.

6Add to playlists
Once your shows or movies have 

fully downloaded you can drag them to 
playlists just like you would with any 
other file in your Library. You can’t edit 
the information about Apple TV+ or 
purchased downloads, though.

3Download for later
If you’re going to be travelling 

or going anywhere where you can’t 
guarantee a decent internet connection, 
you can download shows and movies 
to watch them later. This will add the 
downloaded episodes to your library.

HOW TO Stream and download content via Apple TV

Broadcasters, streamers, and 

filmmakers don’t want people pirating 

their content. One tool to prevent that 

is High–bandwidth Digital Content 

Protection (HDCP). HDCP is present in 

DVI, DisplayPort, and HDMI 

connections, and if all your devices 

and their cables are not HDCP–

compliant content may not play in 4K, 

or at all. If you encounter an HDCP 

error on a new Apple TV it means that 

something between your Apple 

TV and your TV or projector 

isn’t compliant: most likely the 

connecting cable.

In the UK and US it’s legal to 

make a backup copy of lawfully 

purchased media for personal 

use, but illegal to bypass what 

the UK calls “technological 

protection measures” to make 

that backup.

If you get an HDCP error with your Apple TV, 
check the cable between it and your TV.

HDCP,  COPY PROTECTION,  AND THE LAW
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Apple doesn’t put Superdrives into its Macs 
any more, but it happily sells an external 
USB version.

You don’t need to store all your video 

files on your Mac to access them; 

keep them in iCloud Drive and get the 

ones you want directly from Finder. 

We have an Old Videos folder in our 

iCloud Drive for old home movies, and 

access them by Ctrl–clicking a clip, 

selecting Download Now and then 

pressing the Space bar to view using 

macOS’s Quick Look feature. This 

brings up a video window with basic 

play controls, and you can run it full 

screen by clicking the icon next to the 

“X” at the top left of the window. Esc 

brings you back into window mode.

GENIUS TIP:  PLAY FROM iCLOUD DRIVE

ELMEDIA PLAYER

From elmedia-video- 

player.com

Elmedia is a fun, friendly video 

player that can handle all the 

key formats including MOV, MKV, 

and MP4. It integrates well with 

OpenSubtitles and has a useful 

bookmark feature for long clips.

VLC 

From videolan.org

We’ve been using VLC for many 

years now and while it’s not the 

most modern–looking app in the 

world, it’s incredibly lightweight, 

versatile, and effective. It’s also 

free and ad–free, which we think 

is a real bonus.

IINA

From iina.io

Designed specifically for the 

Mac and based on the mpv 

media player, IINA supports Dark 

Mode, Picture in Picture, and the 

Touch Bar. It can play almost 

anything and it’s also 

expandable via plug–ins.

QUICKTIME

From apple.com

QuickTime Player comes with 

macOS and can do more than 

you might expect with it: you 

can carry out edits such as 

splitting or trimming clips and it 

can capture your iPhone or iPad 

screen too.

5K PLAYER

From 5kplayer.com

5K Player isn’t just a player. 

It’s also a streamer with support 

for Apple’s AirPlay and the 

widely supported DLNA 

streaming protocol too. The 

name’s a bit misleading, though: 

its max resolution is 8K! 

> Alternative 
video viewers

There are lots of video 
players, but there’s no 
such thing as a one size 
fits all solution. Where 
IINA is minimalist, VLC is 
packed with power 
features, and 5K Player 
focuses on streaming. 
The players listed here 
should cover most kinds 
of playback.

How to view and convert 
old or unusual formats

OTHER WAYS 
TO WATCH

STREAMING IS GREAT, but what about 

the discs and videos you already have in 

your collection — the home videos you 

shot on old cameras, or your DVDs? 

Third–party viewers (see right) can 

handle many of the formats that Apple’s 

own apps don’t, while an external DVD or 

Blu–ray drive with the combination of 

VLC and Libbluray (from the videolan.org 

site) will take care of disc playback.

That’s fine if you just want to play 

media on your Mac. But what if you want 

to convert it for other apps or devices or 

for backup purposes? That’s where one 

of our favorite apps comes in. Handbrake 

(handbrake.fr, for OS X 10.3 or later) 

makes it really easy to convert pretty 

much anything to pretty much anything, 

and it includes lots of Apple–specific 

presets for your iPhone, Apple TV, and 

more. It can also back up unprotected 

DVDs and Blu–rays.
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4Wait a moment
Infuse will now import all the 

compatible files in the selected folder, 
displaying thumbnails of each one. It 
then shows you a file and folder list; the 
stars next to folders enable you to mark 
them as favorites for fast access.

1Find your files
Infuse (Free, with IAPs, firecore.com) 

works with a huge range of video 
formats including MKV, AVI, WMV, MTS, 
ISO, OGM, and many more. It also plays 
the big names: MOV, M4V, and MP4. To 
begin, click the Add Files button.

7Pick a playlist
If you haven’t used Infuse before, 

you can create a new playlist by 
selecting Playlists > Create Playlist and 
giving your new playlist a name. Once 
it’s created you can then use the same 
menu to add other videos to it.

5View the video
To view a video, double–click it. 

The bar at the bottom of the screen 
gives you the usual playback controls as 
well as the option to enable subtitles or 
switch audio tracks, and to move from 
full screen to big or small windows.

2Choose your source
The basic version of Infuse works 

with locally stored files, but if you take 
out a subscription it can pull videos 
from a range of sources including all the 
big cloud services and some obscure 
ones too. Let’s go with Add Local Folder.

8Change the settings
Infuse’s preferences cover key 

features for advanced users, including 
whether it should download subtitles for 
online videos and how it should sort 
your video library. There are parental 
controls for files that support them.

9Upgrade your app
The core, free app is very good, but 

if you want to unlock the power features 

you’ll need to take out a subscription, 

which isn’t hugely expensive. This gives 

you AirPlay, Google Cast, cloud streaming, 

and very high–resolution format support.

6See the options
If you single–click a video you’ll be 

taken to its information page, and if you 
click on the “…” at the top–right corner 
of the screen you’ll see the additional 
features shown here: Loop, “Mark as 
Watched”, Playlists, and so on.

3Pick the place
We store our various movie files in 

the Movies folder underneath our user 
account. Infuse is interested in folders, 
not individual files, so when you find the 
folder you want to use it’s just a matter 
of clicking on the Open button.

HOW TO Watch your media with Infuse 7
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Chances are that if you’re reading 
MacLife, you’ve got a home so decked 
out in all the latest gadgets that it 

could make Steve Jobs drool. One thing’s for 
sure: we all love our devices and aren’t shy 
about the fact, whether we’re early adopters 
or extreme enthusiasts.

But there’s no need for all that tech 
wizardry to be limited to the confines of your 
home. In fact, many devices positively sing 
when they’re taken on a little outdoor 
expedition. Far from the hand–wringing 
worries you so often read about, tech, and 
nature can exist in perfect harmony — and 
we’re out to prove it.

Whether you’re looking to equip your 
existing devices for the great outdoors or 
stock up on something new and enticing for 
use in Mother Nature, you’ll find it here in 
this feature. We’ve covered the top tech for 
green–fingered gardeners, devices to 
enhance your dream vacation (wherever it 
might be), and what to bring when you hit 
the road with your trusty gear.

So, let’s take the plunge into the techtopia 
that awaits us over the next few pages. By the 
end, you’ll have a good idea of everything you 
need to take your next alfresco adventure to 
another level. After all, there’s a whole world 
out there to explore.

WRITTEN BY ALEX BLAKE

GEAR FOR  
THE GREAT 
OUTDOORS

The perfect tech to bring on your travels, whatever the weather
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Tech that will thrive outdoors come rain or shine
IN THE GARDEN

Arlo Ultra 2
$599.99  
From arlo.com

Keep a watch on your garden 

from your iPhone or iPad with 

the Arlo Ultra 2. This HomeKit 

camera produces 4K footage 

that can zoom in up to 12x, 

has powerful night vision, and 

even lets you speak to any of 

your visitors.

Eve Flare
$99.95 
From evehome.com

Ambient lighting can 

be perfect for a relaxing 

evening outdoors, and Eve 

Flare is a top option. This 

stylish globe emits a subtle 

color of your choice, works 

with HomeKit, and can 

withstand the weather.

Meross Smart 
Outdoor Plug
$23.99
From meross.com

If you’ve got electrical gear 

for the outdoors, you’ll need 

an easy way to operate it. This 

smart plug has IP44 

protection and is HomeKit 

enabled, letting you stay in 

control from your iPhone.

Sonos Move
$399 
From sonos.com

Why let a little water spoil 

your fun? The Move speaker 

from Sonos has IP56 water 

resistance to keep the party 

going through the weather. Its 

11–hour battery and drop 

resistance make it long–

lasting, too.

Nebula Solar 
Portable
$499.99 
From us.seenebula.com

The garden can be an 

excellent spot for movie 

watching, and Nebula’s Solar 

Portable is just the ticket. 

Despite its small size, you get 

a crisp 1080p picture and 

three hours of battery life.

Y ou might think the 
world of technology 
stops at your front 

door, but there’s no reason 
for that to be the case. 
Once you get out into the 
garden, there are all sorts of 
ways your gear can enhance 
your green–fingered 
experience. Whether that’s a 
high–tech take on your 
favorite outdoor tools or 
simply a device that can stand 
up to the elements, there’s a 
lot that gadgets can do for 
your outdoor space.

Over the next two pages, 
we’ve put together a selection 
of devices that will step up 
your garden experience, from 
lights and speakers that make 
social gatherings more fun to 
cameras and weather stations 
that help you keep a closer 
eye on things. 
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Netatmo Smart 
Home Weather 
Station
From $199.99 
From netatmo.com/en-us

This expandable system 

can track anything from 

humidity and temperature 

to noise levels and air 

quality. Add–ons include 

tools to measure rainfall, 

wind speed, and more.

Igloohome Padlock
$129 
From igloohome.co

If you want to secure your 

garden valuables, try the 

Igloohome Padlock. This lock 

combines a keypad and 

Bluetooth functionality so it 

can be controlled from your 

iPhone. It’s versatile and 

sturdy, as well as secure.

Mophie 
Powerstation 
USB–C 3XL Battery
$199.95 
From zagg.com

Keep devices juiced up with 

Mophie’s handy power pack. 

Providing up to 45W of output 

from its 26,000mAh battery, 

it’ll keep a MacBook going for 

up to 17 hours.

Traeger Pro 575
$899.99 
From traeger.com

Traeger’s Pro 575 barbecue 

lets you cook in style by 

connecting to your iPhone, so 

you can monitor and maintain 

temperatures for perfect 

results every single time. It 

takes the tricky guesswork 

out of grilling.
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Top travel tech accessories for the laptop lifestyle
OUT ON THE ROAD

Eastpak Provider
$84.99
From eastpak.com

Eastpak’s Provider may look 

simple, but it has everything 

you want in a laptop 

backpack. There’s a padded 

compartment for your 

MacBook, comfy straps and 

back padding, tons of storage 

space, and more.

Ember Travel 
Mug 2
$199.95
From ember.com

For the ultimate in hot–

drink decadence, try this 

intelligent flask. The 

display on its outer edge 

shows the exact 

temperature of the fluid 

inside, and it just takes 

a few taps to heat things 

up or cool them down.

Nextbase 622GW
$399.99
From nextbase.com

If your car gets in a scrape, 

you want to preserve the 

evidence. The 622GW does 

that superbly. Its outstanding 

image quality comes in 4K or 

120fps, and it can pinpoint 

your incident with the 

geocode system, what3words.

Apple MagSafe 
Battery Pack
$99
From apple.com

Heading out but need to juice 

up your iPhone? Slap one of 

Apple’s MagSafe Battery 

Packs on and you’ll get 

between 40% and 70% extra 

battery life to keep you going 

for longer.

Fidlock Vacuum
$34.99
From fidlock-bike.com

Need directions while cycling? 

Fidlock’s Vacuum iPhone 

mount is ideal. As the name 

suggests, it uses a vacuum 

lock to keep your phone in 

place, so there’s no need to 

worry about any flimsy clasps 

that could break off.

W hen it comes to 
travel, chances are 
you’re looking for 

equipment that can make life 
a little easier when you’re 
away from home. After all, 
it’s not like you can take your 
usual desk set–up wherever 
you go, regardless of whether 
it’s for work or pleasure. 
When you have to travel light, 
you need to make sacrifices to 
your normal tech operations.

But fear not, as we’ve found 
the perfect gadgets for every 
road warrior. There are 
protective cases, battery 
packs, USB hubs, and portable 
monitors — all great for 
working on the go. And we’re 
not just focusing on work. 
We’ve included a dash cam, a 
nifty travel mug, and more, all 
of which are made for the 
gadget lover with itchy feet.
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Marshall Monitor II 
ANC headphones
$319.99   
From marshallheadphones.
com

Marshall’s headphones 

boast excellent active noise 

cancellation and the 

sumptuous sound quality 

we’ve come to expect from its 

famous name.

ViewSonic VG1655
$229.99   
From viewsonic.com

Working on the go doesn’t 

have to mean doing your 

thing in cramped spaces. 

ViewSonic’s external monitor 

gives you more screen real 

estate, with a 16–inch 1080p 

panel that’s lightweight and 

sturdy too.

Native Union Stow 
Slim for MacBook
$79.99
From nativeunion.com

This beautiful laptop sleeve 

combines sublime style with 

plentiful protection. 

Additionally, there’s a 

magnetic clasp and an extra 

pocket for your documents 

and cables.

Satechi USB–C 
Hybrid Multiport 
Adapter
$89.99
From satechi.net

Satechi’s clever accessory is 

more than just a USB–C hub. 

It also includes space for an 

M.2 drive, so it combines 

storage with port expansion. 

It’s a great all–in–one device.

1

2

3 4
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Make more of your explorations with these apps and gadgets
ON VACATION

OtterBox Symmetry 
Series+
$59.95
From otterbox.com

OtterBox is well known for its 

highly protective cases. The 

Symmetry Series+ bucks the 

trend of bulky, overdesigned 

iPhone cases with a svelte 

design that’s both thoroughly 

solid and easy on the eyes.

DJI Air 2S
$999
From dji.com

A drone can help you get 

breathtaking photos and 

videos you’d be otherwise 

unable to capture. DJI’s 

Air 2S is the best of the 

bunch thanks to its 120fps 

footage, large sensor, and 

compact form factor.

Anker PowerCore 
20K
$59.99
From anker.com

Ensuring your devices are 

powered up on holiday can 

be tricky. Anker’s PowerCore 

20K will keep you topped up 

with its 20,000mAh battery, 

which is enough to power 

your devices many times over.

Apple AirTag
$29
From apple.com

There’s nothing worse than 

losing your valuables while on 

holiday. Apple’s AirTag can 

help mitigate that — just pop it 

in a bag or attach it to your 

key fob to trace your 

valuables wherever they go. 

No more panic at the airport.

Joby GripTight 
GorillaPod for 
MagSafe
$69.95
From joby.com

Struggling for that perfect 

angle? Use this tripod, which 

can grip to surfaces using its 

bendable legs. And with 

MagSafe built in, you get a 

solid mounting connection.

A lot of planning goes 
into jetting off on 
holiday, but there are 

some things you might not 
have thought of: how will you 
capture the memories you 
make? How will you ensure 
you don’t lose or damage 
anything valuable? And how 
will you keep your devices 
powered up when you can’t 
get to a wall plug? Luckily, 
there are tech products that 
can help.

Here, we’ve rounded up 
our favorite devices that can 
guarantee your trip is one 
to remember. Whatever you 
want to do, from hiking in the 
mountains off the beaten 
track to taking in the sights at 
a spectacular viewpoint, the 
products here are the perfect 
way to ensure your next 
vacation is your best yet.
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AllTrails
Free (offers IAPs)
From alltrails.com

Want to take a trip to 

the great outdoors? 

AllTrails should be your go–

to app. It shows you curated 

walks, hikes, bike rides, and 

running trails in your area, 

with routes, photos, and 

plenty of key info.

Apple Fitness+
Free (offers IAPs)
From apple.com

Apple’s Fitness+ 

service is a superb way 

to use your Apple Watch to 

get fit and active. You can 

choose from a huge range of 

guided exercises that sync 

your progress to your 

Watch in real time.

Spyglass
$3.99
From happymagenta.com

Spyglass is your all–in– 

one toolbox for 

outdoor adventuring. It 

contains almost everything 

you could need on a trip, 

from maps and a GPS system 

to an augmented reality 

compass and speedometer.

Seek by iNaturalist
Free
From inaturalist.org

We’ve all been on a 

walk and found a plant 

or animal we couldn’t 

identify. Seek by iNaturalist 

helps out here — just point 

the app’s camera at 

the mystery flora or fauna to 

find out what it is.

HidrateSpark Pro
$79.99
From hidratespark.com

Check out this uber–useful 

and clever bottle. Its LED base 

glows to remind you to drink, 

while you can track your fluid 

intake with its companion 

app. If you forget to take a 

sip, that will help keep you 

hydrated while you’re out 

exploring the world. 

THE BEST APPS  
FOR OUTDOORS

GoPro Hero 10 
Black
$529.98
From gopro.com

GoPro’s Hero 10 Black is the 

most versatile action camera 

out there. It throws in so 

many top–class features, from 

4K/120fps recording to 

HyperSmooth image 

stabilization, that you’ll be 

spoiled for choice.

Insta360 ONE 
X2
$429.99
From insta360.com

This 360° camera is the 

perfect way to capture 

footage on your travels. 

We love its ability to 

remove selfie sticks from 

recordings and keep 

horizons level even when 

you rotate the camera.
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why our Reviews section is so 
important to us, and you. We 
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and money on inferior products, 
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only the best hardware and 
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look promising, even if they don’t always deliver.
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no matter which review you’re reading, you can be 
confident the person who’s tested it knows their 
stuff, allowing you to make an informed purchase.
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with half stars, which is easy to understand because 
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Only the 
best…
The products that 

really stand out in 

the mag — those that 

receive a five–star 

rating — get the 

Mac|Life Editor’s 

Choice award. It 

doesn’t get any 

better than this, so 

you’d be mad not to 

buy anything bearing 

this mighty accolade. 
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The Mac Studio is 
festooned with ports, 
including four Thunderbolt 
4 ports on the rear as well 
as 10Gb Ethernet.

E
ver since Apple introduced its first Apple 

silicon Mac in 2020, its direction of travel 

has been crystal clear.  First to arrive were 

the M1–powered MacBook Air, Mac mini, and 

13–inch MacBook Pro in 2020, followed by the 

gorgeous 24–inch iMac in April last year. Last 

October, Apple moved things on again with the 

new 14–inch and 16–inch MacBook Pro offering 

up new members of the M1 family, the M1 Pro 

and M1 Max. Now there’s this, the new Mac 

Studio — a Mac mini on steroids, armed with a 

choice of either an M1 Max or the new M1 Ultra, 

making it the most powerful desktop Mac ever 

made — or at least until the new Apple 

silicon–sporting Mac Pro arrives sometime in 

the coming months.

Thanks to the power of Apple silicon, even 

an M1–powered Mac mini or MacBook Air is 

powerful enough for most people, so it should 

come as no surprise to find that the Mac 

Studio isn’t really aimed at us — instead Apple’s 

target market is the creative pros who edit 8K 

videos, render graphics–heavy scenes and 

produce multitrack audio streams all day long. 

And the new Mac Studio is priced accordingly. 

$1,999 buys you a Mac Studio equipped with 

an M1 Max chip with a 10–core CPU, 24–core 

GPU and 16–core Neural Engine), 32GB of 

unified memory and 512GB of solid–state drive 

(SSD) storage. Spending $3,999 takes you into 

M1 Ultra territory, complete with a 20–core 

CPU, 48–core GPU and 32–core Neural Engine, 

64GB of unified memory, and a 1TB SSD. The 

model on test here shows just how far Apple 

can push even that. Priced at $6,199 (via the 

Mac Studio’s Configure To Order options), it 

comes with a 20–core CPU, 64–core GPU, 32–

core Neural Engine M1 Ultra, plus 128GB of 

unified memory and 2TB of SSD storage. 

Increasing the storage to 4TB will cost you 

another $600, while adding 8TB costs $1,800. 

It’s not really a machine for a bit of web–

surfing and the occasional email then.

No matter which build–to–order Mac Studio 

you buy, the rest of the specs largely remain 

the same. On the front, you’ll find two USB–C 

ports (M1 Max versions) or two Thunderbolt 4 

ports (M1 Ultra versions), plus an SDXC card 

slot, while on the rear all variants get four 

Thunderbolt 4 ports, a 10Gb Ethernet port, one 

HDMI 2.0 port and a 3.5mm headphone jack. 

On the underside of the unit you’ll also find a 

security slot, enabling you to lock the Mac 

Studio to your desk, making it less likely 

someone will walk off with it.

When it comes to design, the Mac Studio 

really is just like an oversized Mac mini — it has 

the same 7.7x7.7in footprint as the mini, but 

stands taller at 3.7in, and its aluminium shell 

has cheesegrater–style vents on its rear and 

underside, enabling the huge twin fans inside 

to suck in air and draw it over the built–in 

power supply and logic board. Like most other 

Macs, these days, the Mac Studio also comes 

with Wi–Fi 6 (802.11ax Wi–Fi) and Bluetooth 5.0 

wireless connectivity.

It’s worth noting at this point that just like 

the Mac mini, the Mac Studio is sold without 

either an accompanying mouse, trackpad, or 

keyboard. To that end, Apple has launched 

special black editions of the Magic Mouse 

($99), Magic Trackpad ($149), and Magic 

Keyboard with Touch ID and Numeric Keypad 

($199). Notably, it hasn’t taken the opportunity 

to change the way the Magic Mouse charges, 

though, or added backlighting to the Magic 

Keyboard’s keys (which seems like a bit of a 

missed opportunity to us, given that the Mac 

Mac Studio
Apple’s most powerful desktop Mac is brilliant 
for creative pros, but it won’t be for everyone

You also get two USB–A 
ports and an HDMI port, as 
well as a 3.5mm 
headphone jack.
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When it comes to design, the Mac 
Studio really is just like an oversized 
Mac mini.
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Studio is likely to be used in studio 

environments with low lighting, especially 

when editing video and the like).

The Mac Studio is also decidedly non–user 

upgradeable, with ifixit.com awarding it 6 out 

of 10 for repairability, noting that while you 

could potentially swap out the removable 

storage using another SSD of the exact same 

specification, attempting to replace it with 

higher capacity storage is a no–go (for now). 

As for rest of the components — unfortunately, 

you’re stuck with what you chose when placing 

your order.

ULTRA POWERFUL

While you could buy the Mac Studio with an M1 

Max, most creative pros are likely to opt for 

the M1 Ultra, as that’s where this machine’s 

true power lies. As Apple pointed out during 

its Peek Performance event, the M1 Ultra is 

essentially two M1 Max die “joined” together 

with computing tasks distributed between 

them using Apple’s proprietary UltraFusion 

architecture. This, Apple says, delivers up 

to 2.5TB/s of low–latency inter–processor 

bandwidth, which in turn helps the M1 Ultra 

deliver up to 3.8x faster CPU performance, 

4.5x faster GPU performance and 3x faster 

machine learning performance than the Intel–

powered Mac Pro and iMac models Apple 

chose to benchmark the Mac Studio against. 

Apple even says the Mac Studio outperforms 

many desktop–class PCs, and that’s true to an 

extent, but things are more nuanced than that.

Just like all the other Apple silicon Mac’s 

we’ve tried, the Mac Studio is fast to start 

up and super–slick to use, with almost every 

application we tried typically launching quickly.

Editing images in apps such as Photos or 

Affinity Photo is friction–free too, and even 

rendering 3D scenes in Blender gave us super–

quick results, often taking just minutes where 

it can take hours on the Intel–based MacBook 

Pros we normally use in the Mac�|Life office.

The front of the Mac 
Studio gets either two 
USB–C ports or two 
Thunderbolt 4 ports, 
depending on 
configuration.

Benchmarks: Our analysis explained

Mac Studio 3.22GHz M1 Ultra (2022) Mac Studio 3.22GHz M1 Ultra (2022) Mac Studio 3.22GHz M1 Ultra (2022) Mac Studio 3.22GHz M1 Ultra (2022)

Mac mini 3.0GHz 8–core M1 (2020) Mac mini 3.0GHz 8–core M1 (2020) Mac mini 3.0GHz 8–core M1 (2020) Mac mini 3.0GHz 8–core M1 (2020)

iMac 27in 3.6GHz 10–core Intel Core i9 (2020) iMac 27in 3.6GHz 10–core Intel Core i9 (2020) iMac 27in 3.6GHz 10–core Intel Core i9 (2020) iMac 27in 3.6GHz 10–core Intel Core i9 (2020)

1784

23 mins 38 secs

7 mins 33 secs

1742

1388

9 mins 10 secs 30

59

28 mins 42 secs

6 mins 30 secs

3 mins 39 secs

> GEEKBENCH 5 SINGLE–
CORE TEST

This tests the capability of a single 
processor core. Many more common 
tasks on a Mac will only use a single 
core at a time. Geekbench 5 is a 
universal app running on Monterey.

Index score (higher is better)

> HANDBRAKE 
VIDEO ENCODING

We transcode a Blu–ray–quality 
video file into H.264 format using 
HandBrake to test the multicore 
processor performance. Handbrake 
is available as a universal binary.

Duration (lower is better)

> TOMB RAIDER 
(1920X1080)

For a real–world gaming test, we 
use the benchmarking tool in this 
game, with the graphics quality set 
to High, and the resolution set to 
1920x1080. Not yet optimized for M1.

Frames per sec (higher is better)

> DAVINCI RESOLVE

In Blackmagic Design’s editing tool 
for video professionals, we exported 
an effects–laden, 2.5–minute project 
to the H.264 format. The latest 
version of the app (Version 17.1) 
now runs natively on M1 Macs.

Duration (lower is better)

30
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In Geekbench 5’s single–core processor test, 

the Mac Studio hit a consistent score of 1,784, 

putting it on a par with other M1 Macs (see the 

table above). This isn’t too surprising as the 

underlying architecture is the same. Where the 

Mac Studio really hits it out of the ballpark is 

in the multicore test, where that 20–core M1 

Ultra CPU achieved 23,944 — or over twice 

that of a 27–inch iMac with a 3.6GHz 10–core 

Intel Core i9, which averaged 10,002.

The Mac Studio aced our DaVinci Resolve 

benchmark test too (rendering an effects–

laden 2.5–minute video), taking just 3 minutes, 

39 seconds to produce the finished clip, 

compared to 6 minutes, 30 seconds on the 27–

inch Intel iMac, and 28 minutes, 42 seconds on 

a Mac mini equipped with a standard M1.

However the Mac Studio delivered mixed 

results in our next two tests. In Handbrake, the 

Mac Studio managed to transcode a one–hour 

long 4K video into MP4 in 9 minutes, 10 

seconds; 2 minutes, 13 seconds slower than an 

Intel Core i9 iMac. Gaming performance in Rise 

of the Tomb Raider was also sub–par, 

averaging 30 frames per second (fps), 

compared to the Intel Core i9 iMac’s 59fps. 

That could be because the game isn’t 

optimized for the M1, but the Mac Studio also 

performed surprisingly poorly during our 

Shadow of the Tomb Raider test. While there it 

managed to clock up 117fps — it did so only by 

frequently dropping frames using the in–game 

benchmark setting at 1980x1080 resolution, 

while actual use in–game resulted in the same 

jerky performance. The Mac Studio may be a 

great rendering machine, but games console 

or even gaming PC replacement it is not.

So should you buy the Mac Studio? If you’re 

a creative pro who edits 8K video all day, the 

answer is yes. But for the rest of us? You could  

justify buying the $1,999 M1 Max version as an 

ageing iMac replacement. But the M1 Ultra? 

No. As interesting and as powerful as it is, it’s 

overkill for the day–to–day tasks you’re most 

likely to want to do. 

THE BOTTOM LINE. Super–quick and 

powerful, the M1 Ultra Mac Studio is overkill 

for the most of us. ROB MEAD–GREEN

THE MAC STUDIO MAY BE A GREAT RENDERING  
MACHINE, BUT GAMES CONSOLE IT IS NOT

MAC STUDIO

$6,199 (model on test)
apple.com

Features Apple M1 Ultra 
chip (20–core CPU, 64–
core GPU, 32–core Neural 
Engine), 2TB storage, 
128GB of unified memory, 
Wi–Fi 6 (802.11ax), 
Bluetooth 5.0, 6x 
Thunderbolt 4 ports (2x 
front, 4x rear), 2x USB–A 
ports, 1x 10Gb Ethernet 
port, 1x HDMI 2.0 port, 1x 
3.5mm headphone jack, 1x 
SDXC card slot, 
7.7x7.7x3.7in, 7.9 pounds

  �Ultra–fast CPU 
performance

  Good port selection

  �Very expensive

  M1 Ultra is overkill

GOOD 

The two huge fans behind the Mac Studio’s grille are mercifully quiet, even when the machine is working hard.
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N
ow that the 27–inch iMac has joined the 

Power Mac G4 Cube and the original 

MacBook in the great big Apple resting 

place in the sky, the new Studio Display could 

be the next best thing. Maybe. Released 

alongside the new Mac Studio, the Studio 

Display sports a 27–inch 5K Retina display 

and even bears a passing resemblance to the 

24-inch iMac. It is also only Apple’s second 

display of the modern era, joining the 32–inch 

Pro Display XDR ($4,999), but at a more 

reasonable $1,599.

We say “reasonable”, but there’s a catch. 

The $1,599 price either gets you a Studio 

Display with a fixed height but tilt–adjustable 

stand or a VESA mount. For a height–

adjustable stand you’ll need to spend an 

extra $400. Where rival monitors often 

include a height–adjustable stand and a VESA 

mount option as standard, Apple forces you 

to choose the one you want at buying time. 

You can, however, change your mind later and 

take the Studio Display to your local Apple 

Store and get the stand swapped out for 

another. And if you want non–reflective 

nano–texture glass? That’ll be an extra $300.

Also controversial is the use of a braided 

power cable that comes pre–attached to the 

display and can only be removed using a 

proprietary tool. The Studio Display also 

comes with a single Thunderbolt 3 input. 

While this means you only need to connect 

one cable to your Mac (and have it charge at 

the same time if it’s a MacBook Air 

or MacBook Pro), anyone needing HDMI or 

DisplayPort connections will need to buy 

an adaptor (there are none included).

MISSING IN ACTION

While the Studio Display’s 5K Retina 

screen looks great, it’s also missing the 

kind of features you’d expect to find in 

a monitor at this price — such as High 

Dynamic Range (HDR) support or a 

100Hz or higher refresh rate. The lack 

of the former seems particularly 

egregious when the Studio Display is 

supposedly aimed at creative pros 

(or anyone who wants to watch HDR 

videos they’ve bought on iTunes), 

and also odd given that the Mac, 

iPhone and iPad all support HDR, 

with some (the iPad Air and iPad 

Pro) supporting 120Hz refresh 

rates too.

Things get stranger when you 

discover that the Studio Display is 

powered by the same A13 Bionic 

chip used on the ninth–gen iPad and runs 

iOS 15.4. Still, there’s always the 12MP Ultra 

Wide webcam and Center Stage — only the 

jury’s still out on that, as Apple’s promised 

update to fix a webcam quality issue was still 

to materialize as we went to press.

At least the Studio Display sounds as good 

as it looks — with six speakers and support 

for Spatial Audio as well as three studio–

quality microphones. It also comes with a 

three–port USB–C hub, enabling you to hook 

up peripherals directly to the display rather 

than your Mac. 

THE BOTTOM LINE. While it’s great to 

have another monitor option from Apple, we 

believe the Studio Display has limited appeal. 

ROB MEAD–GREEN

Studio Display
The 27–inch 5K Retina display has some surprise  
hits — and misses

STUDIO DISPLAY

From $1,599
apple.com

Features 27–inch 5K 
Retina display (5120x2880 
pixels), 600 nits 
brightness, True Tone, 1x 
Thunderbolt 3 port, 3x 
USB–C ports

  �Bright, colorful 
5K Retina display

  Built–in USB–C hub

  �Costly options

  �No HDR or high refresh 
rate support

SOLID 

The Studio Display only 
has a single Thunderbolt 3 
input, but at least it can 
charge your MacBook at 
the same time.
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You can choose from two 
anti–reflective glass 
options. 
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Image rights: Aqara.

There aren’t a lot of security cameras that 
support HomeKit, but Aqara’s new indoor 
camera, the G2H Pro, does, and it costs just 
$69.99. The compact camera is neatly 
designed, standing just 3.26 inches high, 
with a magnetic tilt–and–swivel base, and 
there’s a wall–mount kit included as well, so 
it’s easy to set the camera up. 

Despite the low cost, the G2H Pro provides 
1080p resolution, and produces a clear, sharp 
image with an impressive 146–degree 
viewing angle. There’s a bit of “fish–eye” 
distortion in the image, but many people will 
accept that in order to get that wide viewing 
angle. The low–light mode isn’t perfect — 
making out facial features at night is still a 
bit tricky — but it’s clearer and sharper than 
we’ve seen on several more expensive 
cameras. The camera provides a micro–SD 
card slot for storing your video recordings, 
but the HomeKit support means that you can 
also use an iCloud+ subscription (from $1 per 
month) to store video online too. The G2H 

Aqara Camera Hub G2H Pro
An affordable, 1080p security camera with HomeKit support

Pro even acts as a hub that can control other 
Aqara accessories, such as door sensors. 

The Aqara app is a little fiddly to set up. It 
took a few attempts to create a password and 
scan the QR code required to connect the 
camera to Wi–Fi — but once that’s done it’s 
quick and easy to use, and provides 
instructions. The low cost does involve some 
compromises, though. The camera doesn’t 
have a battery, so it has to be powered 
through a micro–USB port. However, Aqara 
doesn’t include a mains power adaptor — all 
you get is a 6.5 ft USB cable, so you have to 
provide a USB power adaptor yourself, or 
connect the camera to a Mac or other device 
that can provide power via USB. It only 
supports 2.4GHz Wi–Fi too, although other 
Aqara cameras do support 5GHz if required.

THE BOTTOM LINE. The lack of a 
rechargeable battery is a little disappointing, 
but the G2H Pro provides a high–quality 
security camera and HomeKit support at a 
bargain price. CLIFF JOSEPH

The G2H Pro provides 
1080p resolution, wide–
angle lens, and HomeKit 
support.

AQARA CAMERA 
HUB G2H PRO

$69.99
aqara.com

Features 1080p 
security camera, 146–
degree wide–angle 
lens, night–vision 
mode, magnetic tilt–
and–swivel stand, 
micro–SD slot, 
HomeKit support

  HomeKit ready

  Competitive price

  1080p, wide–angle lens

  �Requires mains or USB 
power

GREAT 
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Compatible with any iPad that has a USB–C port, this hub 
fits snugly to the body and is sturdy when attached. To the 
iPad’s meagre single port it adds six extra interfaces plus 
media control buttons for music and movies on the device. 
There’s a USB–C port with 5Gbps data and 60W of power 
delivery for charging, and even though the largest iPad can 
only accept around 20W of power for charging, this is handy 
when using the hub via its extension cable with a Mac. 

There’s a USB–A port also rated at 5Gbps which is the 
same as the smaller iPads, though the Pro’s USB–C allows 
10Gbps data transfer and more for the M1 model. An HDMI 
port allows 4K output at 60Hz, which is impressive. SD and 
MicroSD UHS–I card readers are available at 104MB/s — not 
as fast as UHS–II but still fairly speedy. A 3.5mm audio out 
jack rounds out the ports.

The media buttons are a great feature if you like to listen 
to podcasts or music in split view while working on your 
iPad. The ports are similar speeds to other self–powered 
USB–C hubs, though this one takes up little space.

THE BOTTOM LINE. A solid hub for iPads with USB–C, if a 
little expensive. HOLLIN JONES

Twelve South’s wireless charging stand is ideal for 

your office space or bedside table. It features a 

wireless charging pad embedded within a clear 

Lucite frame. This frame slots neatly inside a 

chunky white stand — horizontally or vertically. 

Just place your iPhone (or AirPods with a wireless 

charging case) on the stand and it’ll start charging; 

a rubber strip keeps the device in place. Due to the 

iPhone 13 Pro’s large camera bump, it doesn’t 

quite sit flush, which is a little annoying. It also 

doesn’t work with MagSafe cases… bummer.

The mod’s USP is a removable clear front plate 

allowing you to display a 4x6 photo or print. The 

plate attaches magnetically, so once your chosen 

4x6 is in place, the plate snaps on. This is tricky 

initially, as the print tends to move out of place. 

The stand can also be used in its “naked” form.

At the back there’s a port for connecting the 

included USB–C to USB–C cable, which is just long 

enough to work with. You’ll need at least a 20W 

adapter to charge your chosen device with.

As is the norm, wireless charging is limited to 

7.5W on iPhone, so don’t expect speedy results.

THE BOTTOM LINE. A clever idea, but this 

attractive stand has foibles. NICK ODANTZIS

HYPERDRIVE 6–in–1 
USB–C Media Hub
Connectivity for USB–C iPads
$99.99  From hypershop.com

Features 6 essential ports, media shortcut keys Needs USB–C

PowerPic mod
Unique wireless charging 
stand with some quirks
$59.99  From twelvesouth.com

Features Wireless charging, photo frame

HYPERDRIVE 6–IN–1 USB–C MEDIA HUB

  Good port selection

  Extender cable for Macs

  Media buttons are useful

  �Pricier than similar models

GREAT 

TWELVE SOUTH POWERPIC MOD

  A neat way to present your photos or artwork

  Can charge a variety of devices

  Only 7.5W wireless charging

  Doesn’t work with MagSafe cases

GOOD 

Image rights from left: HYPER, Twelve South LLC.
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Spigen’s protective case is the least expensive on test, though 

it looks and feels like a quality product. Attaching the Apple 

Watch inside the case is easy — just push it in from underneath 

and it pops into place. The thermoplastic polyurethane is 

substantial, and offers protection all the way around with raised 

bezels to keep the screen safe. Our only gripe is that the raised 

section above the digital crown makes operating the dial tricky.

That aside, there’s lots to like. It’s comfortable to wear and 

has the most traditional watch feel here. There’s plenty of 

adjustability in the strap to get a good fit, whatever your wrist 

size, a decent metal clasp, and a chunky housing to slot the 

strap in to. The case is available in lots of great colors to suit, 

including Military Green, Black, and Charcoal Gray.

Element Case’s offering looks more at home on a battlefield 

than a coffee shop, and offers military style protection, with a 

double reinforced construction which is said to “suspend and 

absorb G–Forces for superior impact protection”.  To install a 

Series 7, seperate the two halves of the case. The inner cradle is 

the first line of defence, while the outer adds an extra barrier.

This outer layer features Watch Screen Barricade, consisting 

of raised edges around the screen, and an integrated protective 

strap. This is tucked away in the body of the watch strap when 

not in use; when you want extra screen protection just unfasten 

it and hook it over the case. Couple of downsides: first, in 

everyday use the strap often detaches from the main watch 

strap. Second, once it’s hooked on, it’s tricky to remove.

  Amazing protection    Protective strap isn’t great  GOOD   Value–for–money protection    Digital crown access GREAT 

> Element Case Special Ops
$49.95  From elementcase.com

Features Available in 41 or 45mm sizes, black/olive or black/
red, Watch Screen Barricade, Shock Deflection Armor Tech 

> Spigen Rugged Armor Pro
$29.99  From spigen.com

Features Suitable for 44/45mm sizes (works with Series 4, 5, 
6, 7, and SE), raised bezels, shock–absorbent layer

The best protective cases for Apple Watch S7
These watch/strap combinations will keep that pretty face scratch free 

Image rights: Spigen, Inc, Element Case 2022.46   JUN 2022
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Catalyst’s Active Defense Case is more minimalist than others 

here, yet it offers lots of protection, including 10ft drop 

protection (MIL–STD–810G). The case allows for undhindered 

access to all the Watch S7 functions, including wireless 

charging, and Catalyst’s Aqua Drainage System allows water to 

easily drain out of the case. 

The strap is designed for a wrist circumference of 4.9 — 6.9 

inches. It feels lightweight and rests comfortably on the wrist, 

aided by its breathable design which helps to prevent a build up 

of sweat underneath. Catalyst has incorprated a toggle into the 

underside of the strap housing, which allows it to slot in place. 

This prevents the strap from coming out over time, which is a 

very neat addition. The case only comes in black, sadly.

The Otterbox Watch Bumper Case is a standalone case, so no 

watch strap. That’s either a good or bad thing, depending on 

your needs. If you have a strap you already like, it’s a boon, 

providing it matches your strap (four color cases are available). 

If you don’t, Otterbox offers matching straps to suit. The case 

itself is $24.95, while straps retail for $29.95, so if you’re going 

all in, then the Otterbox duo is the most expensive option here. 

As for protection, the Watch Bumper has a minimalist profile, 

but does cover all exposed areas, and the raised face edges 

offer a barrier against knocks or scuffs. It also features 

antimicrobial technology, which Otterbox says helps protect the 

exterior from bacteria. All controls are easily accessible, and 

overall it’s an attractive, discreet case that wont draw attention.

  Subtle, yet protective    Comfortable to wear  AWESOME   Minimalist profile     Duo is expensive  GREAT 

> Catalyst Active Defense Case
$49.99 From catalystcase.com

Features Available in 41mm or 45mm sizes, 10ft drop 
protection, aqua drainage system, breathable strap

> Otterbox Watch Bumper
$24.95  From otterbox.com

Features Available in 41mm or 45mm sizes, case–only (no 
strap), four colors, antimicrobial case, 90% recycled plastic

O
f all the Apple devices out there, 

one could argue that the Apple 

Watch is the most susceptible to 

damage. That’s not surprising given that 

you wear one nearly all day, every day, 

and because of its location it’s likely to 

come into contact with surfaces — more 

so if you are either a bit clumsy, or you 

do a lot of physical work.

So, if you want to avoid scratches (or 

worse) to the screen or case, getting a 

protective case for your Apple Watch is a 

no–brainer really. Here, we’ve got four of 

the best specifically for the Series 7, for 

both screen sizes. It’s worth nothing that 

the majority of the products are a case 

with integrated strap, replacing your 

current strap. NICK ODANTZIS

Image rights: 2022 Otter Products LLC, Catalyst Case US 2022.

EDITOR’S
CHOICE
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Image rights: Keychron.

Not everyone wants or needs a wireless 
mouse — for some, the convenience of never 
having to recharge and also the weight 
saving from not having a battery are 
preferable. Keychron’s M1 is a stylish and 
ultra–lightweight wired mouse that uses the 
supplied 6 ft USB–C cable for data and power. 
It also comes with a USB–A adapter and you 
can use a longer cable should you wish. The 
body itself is incredibly lightweight at just 
2.4 oz and is semi–open, with its internal 
circuitry partly visible. This also reveals the 
animated RGB lights.  

Its sensitivity, important for gamers who 
wish to customize behavior, can be set from 
1200–5000 in steps of 100 via a button 
underneath or the MacOS app which also lets 
you customize its seven top buttons. These 
comprise left and right, a clickable central 
scroll wheel and two smaller buttons on 
either side. A range of commands can be 
assigned to each, with some Mac–specific 
options available too. There’s also the option 

Keychron M1 Mouse
A lightweight mouse with plenty of options

in the app to record macro commands and 
assign those to specific keys. 

The light scheme can be cycled using a 
button on the base, and internally there’s an 
ARM Cortex chip powering things. The 
polling rate — the accuracy with which the 
mouse reports its position — can be set as 
high as 1000Hz which makes it extremely 
responsive. Keychron claims a lifespan of up 
to 70 million clicks, too. 

In extended use the lightness of this 
mouse is a definite bonus, and it’s much less 
likely to tire your hands and arms than using 
a heavier model. Even if you don’t bother 
with macros, being able to assign custom 
functions to buttons is helpful, as are the 
various sensitivity settings you can choose. 
None of this is particularly hard to do and 
should be perfectly accessible, even to less 
technical users. 

THE BOTTOM LINE. A comfortable, 
customizable mouse with adjustable 
settings, ideal for any user. HOLLIN JONES

Extremely lightweight at 
just 2.4 oz, the mouse 
powers over USB–C and 
is a wired–only model.

KEYCHRON M1 
MOUSE

$39
keychron.com

Features RGB effects, 
up to 70 million clicks 
lifespan, type–C 
interface

Needs USB–C, USB–A, 
macOS 11 or later

  Nicely configurable

  Comfortable to use

  Unique design

  �Could be sturdier

GREAT 
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Image rights: Other World Computing, Inc.

OWC MINISTACK 
STX

DIY enclosure $279, 2TB 
HDD $349, 2TB SSD $599
owcdigital.com

Features 1x SATA bay, 1x 
SSD bay, 3x Thunderbolt 4 
ports, 1x Thunderbolt 4 
host port with 60W PD

Needs macOS 11.1 or 
later for Thunderbolt 
hosts, macOS 10.14.6 or 
later for USB hosts, 
iPadOS 14.1 or later, USB–C, 
Thunderbolt 3 or 4

  �Elegant upgrade for 
Mac Mini

  Add lots of storage

  �Chain many USB 
devices

  �Pre–built is pricier than 
doing it yourself

GREAT 

The unit is the same 
shape as a Mac Mini and 
contains an expansion 
hub and two drives.

The Mac Mini is pretty powerful 
considering it’s Apple’s most affordable 
Mac, but it is limited in terms of its ports 
and storage upgrade options, topping out 
at 2TB, an upgrade that adds significantly 
to the cost. OWC’s miniStack STX is an 
external drive and Thunderbolt expansion 
hub that’s the same size as the Mini and 
designed to sit underneath it. It has one 
2.5 / 3.5 inch SATA and one NVMe M.2 SSD 
slot inside and you can supply your own 
drives or choose from one of the many 
available pre–filled configurations. These 
go as high as a massive 26TB for $1959. 

Powering from the mains and 
connecting to your Mac Mini or indeed 
other USB–C–capable device like an iPad 
Pro via a dedicated Thunderbolt port, the 
three additional Thunderbolt ports let you 
connect up to five devices each in 
independent chains, supply up to 60W of 
power to a laptop and connect one 8K 

display at 30Hz or two 4K displays at up to 
60Hz via a Thunderbolt display or a 
USB–C display adapter. Thunderbolt 4 
speeds and features are supported where 
your Mac allows, or lower but still 
impressive speeds where your hardware 
has Thunderbolt 3 or USB–C. 

OWC’s claim of up to 770MB/sec of data 
transfer using the SSD drive proved to be 
accurate in tests, and it makes sense to 
store high–data–rate files like 8K video 
on the SSD drive while offloading less 
demanding data onto the more capacious 
HDD, which is still plenty fast enough for 
everyday operations. This is a solid and 
well–designed way to upgrade your Mac 
Mini, especially for content creators, with 
a good range of storage options as well as 
the ability to use your own drives.

THE BOTTOM LINE. A compact and 
flexible way to power up your Mac Mini. 
HOLLIN JONES

OWC miniStack STX
Add up to 26TB of storage to your Mac Mini 

Tough testing, trusted ratings
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THE BEST APPS 
TO BE MORE 
PRODUCTIVE

GROUP  
TEST
REVIEWED BY KENNY HEMPHILL

ON TEST...
> 2Do
> GoodTask
> Microsoft ToDo
> OmniFocus 3
> Things 3
> Todoist

Need to get better organized? These task management 
tools will help you get more done
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T
HERE’S NO SHORTAGE of 

productivity apps on the Mac. 

But that can make choosing 

the best one all the more difficult. 

They range in complexity from the 

simplest, text–based to do list 

apps, to full–blown “getting things 

done” (GTD) task managers that 

while extremely powerful, require 

an investment of time in learning 

how to use them and a 

commitment to use them regularly. 

So, the first question to ask 

yourself when you’re trying decide 

which is right for you, is “what do 

you want to do with it?” Do you 

want an app where you can make 

the occasional to–do list and check 

things off when they are done, or 

do you want a tool you will use 

daily that will manage everything 

you have to do and allow you to 

delegate and share tasks? 

We’ve covered both ends of the 

spectrum here. In considering 

which apps to include, we’ve stuck 

rigidly to those apps whose 

primary purpose is managing 

tasks. So, while the likes of 

Evernote and Reminders, and 

several calendar apps have to–do 

list features, we’ve ignored them 

for this round–up.

How we tested
We used each app to create and manage a 

range of tasks and examined whether we 

could share or delegate them, sync them 

with other devices, and share to them from 

other apps. 

We took note of how quickly they 

synced, and whether they intelligently 

surfaced tasks based on their start or due 

dates. We also considered the user interface 

and how easy or difficult it made utilizing 

the app. 

Finally, we looked for unique features 

that made each app stand out from its 

competitors in the crowd.
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1 You can use 2Do as a 

basic task manager 

and create lists, add tasks to 

them, and schedule tasks. 

And it does a good job of 

alerting you when tasks are 

due and highlighting them in 

the app, including location–

based notifications. However, 

it’s also a pretty powerful 

project management tool. 

You can create projects and 

tasks can be broken down 

into sub–tasks. There’s a 

quick entry feature that 

allows you to add tasks from 

anywhere using a global 

shortcut. And it has a highly 

customizable search tool that 

allows you to slice the data 

2Do holds any way you want. 

2Do offers several options 

for syncing, including iCloud 

and Dropbox. However, it 

won’t pull in reminders from 

the Reminders app. It has 

share and actions extensions, 

but there’s no Today widget 

or Shortcuts actions. And 

there are no tools for sharing 

tasks with other users. You’ll 

also need to spend time 

learning how to use some of 

its more advanced features 

to get the most from it.

2 GoodTask’s primary 

aim is to allow you to 

filter, view, and manage tasks 

synced with Apple’s 

Reminders and Calendar 

apps as easily as possible. So, 

if integration with those 

stock apps is important, it 

should be near the top of 

your list. 

Task lists are imported 

from, and synced with, 

Reminders but that’s just the 

start. Each list can be filtered 

so that you only see tasks 

that meet certain conditions 

or contain tags you specify. 

Quick Tasks allow you, at the 

click of a mouse or press of a 

keyboard shortcut, to apply 

parameters to tasks such as 

adding it to a list or applying 

a tag, or even pushing its due 

date back by a day. 

A new Board view allows 

you to see tasks due today, 

tomorrow, and further out in 

lists side by side, or to do the 

same with tasks sliced by 

priority, tag, or list. GoodTask 

can also suggest what you 

should focus on now. There’s 

a Today widget and share 

extensions, but sadly no 

Shortcuts actions.

  Excellent search

  Location–based notifications

  Doesn’t import from Reminders

  Can’t share tasks

GOOD 

  Lots of ways to filter tasks

  Can manage tasks quickly

  Quick Tasks is powerful

  Takes time to learn

GREAT 

> 2Do > GoodTask
$49.99 (Mac); $19.99 (iOS)  From 2doapp.com $39.99 (Mac); $9.99 (iOS)  From goodtaskapp.com

Things to consider…
>>> Does it sync?
Is there an iOS or iPad OS version of the 

app. How do they sync? Some apps use 

their own servers to sync, while others 

use iCloud. Consider if you even need a 

mobile version of the app.

>>> Single– or multi–user?
If you want to use the productivity app as 

part of a team, you’ll need features that 

allow you to share and delegate tasks.

>>> Does it work with other apps?
Some of the tools here allow you, via 

share sheets, to add tasks from other 

apps, like email clients. That can be useful 

if you regularly create tasks from email 

messages or calendar events.

>>> How does it show upcoming tasks?
A good task manager will highlight tasks 

that are due on the current day or that 

are overdue.

1

2

Image rights: Beehive Innovations, haha Interactive.52   JUN 2022
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3 Microsoft To Do is an 

evolution of 

Wunderlist, which the 

company acquired a few 

years ago. Luckily, To Do will 

be familiar if you ever used 

Wunderlist. It retains the fast 

syncing that was a key 

feature of its predecessor, as 

well as the option to choose 

an image as a background to 

lists, rather than a flat color.

Tasks can be delegated to 

others, and you can create 

projects and place tasks in 

them. Scheduling tasks is 

easy. However, we weren’t as 

impressed with the My Day 

view. The app suggests tasks 

to place in this view, but to 

see suggestions you must 

click on the lightbulb button 

and then select from what 

often looks like a random 

collection of tasks. It doesn’t 

automatically place tasks 

with a due date of the 

current date in My Day. 

However, the Planned view 

allows you to see which tasks 

are overdue, and which are 

due soon. 

There are no sharing 

extensions, Today widgets, or 

Shortcuts actions. 

4 OmniFocus is based 

around the Getting 

Things Done (GTD) 

methodology and whether 

it’s right for you or not is 

likely to come down to how 

invested you are in that way 

of doing things. It has all the 

features you would expect of 

a powerful task manager, 

including Custom 

Perspectives that allow you 

to view tasks that meet 

specific criteria, such as 

those you can do sitting at 

your desk, or in under 15 

minutes. You can use tabs to 

view only the projects that 

are relevant to you at that 

moment. And there’s a 

Forecast view that allows you 

to see tasks that you need to 

work on in the near future.

You can sync with the iOS 

and iPad OS app, and with 

the web version (extra on top 

of the subscription fee). But 

it doesn’t pull in reminders 

from Reminders. There’s no 

support for sharing tasks. 

However, there are Today 

widgets, sharing extensions, 

and several Shortcuts 

actions, and it feels like a 

Mac app.

  Can delegate tasks

  Planned view

  Free

  My Day could be better

GOOD 

  Custom perspectives

  Excellent OS integration

  Forecast view

  No task sharing

GREAT 

> Microsoft To Do > OmniFocus 3
Free  From microsoft.com Standard $49.99; Pro $74.99  From omnigroup.com

3

4
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5 Things might be one of 

the more expensive 

apps here, especially once 

you factor in paying for the 

iPhone and iPad versions, but 

it offers plenty to justify the 

cost. Its developers have 

been quick to add support for 

new OS features such as 

Today widgets, Shortcuts, 

extensions, and Quick Notes. 

You can set reminders for 

scheduled tasks and the 

Today View displays any task 

that has a start date or 

deadline today or is overdue. 

And reminders you add in the 

Reminders app can be added 

to your Things inbox with a 

click. Additionally, it also 

syncs with iCloud Calendar.

One of our favorite 

features is Quick Find. Start 

typing anywhere in the app 

and a search box displays 

results that update as you 

type. For example, start 

typing “deadline” and click 

the filter to see tasks with 

deadlines today.

You can create projects, 

move tasks using keyboard 

shortcuts, and sync with 

iPhone, iPad, and Watch.

6 Todoist allows you to 

add tasks quickly from 

anywhere by using a 

keyboard shortcut. And its 

natural language support 

makes typing new tasks easy. 

There’s a Safari extension 

that allows you to create a 

task from the currently open 

web page, as well as a share 

extension, Today widget, and 

Shortcuts action. 

You can share projects and 

delegate tasks with anyone, 

whether they use an Apple 

device or not, thanks to its 

Windows, Linux, Android, and 

web versions. And there is a 

feature that monitors your 

completed tasks and builds 

streaks, allowing you to see 

them as a graph. It’s a useful 

motivational tool.

You can’t import tasks 

from Reminders. And you’ll 

have to create an account to 

use the app and sync with its 

cloud service. 

Todoist’s basic version is 

free but if you want access to 

streaks, reminders, automatic 

backup, or want to be able to 

email tasks, you will need to 

pay a subscription for the 

premium version.
  �Excellent integration with OS 

features 

  Quick Find

  Extensions

  �Expensive for all versions

EXCELLENT 

  Basic version is free

  Keyboard shortcuts galore

  Safari extension

  Can’t import from Reminders

GREAT 

> Things 3 > Todoist
$49.99 (Mac); $9.99 (iOS)  From culturedcode.com Free; $3.99/m or $35.99/yr for Pro Plan  From todoist.com

6

5
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THINGS 3
It checks all the boxes for syncing and integrating with macOS, 

and allows you to focus on important tasks

T
HINGS 3 CHECKS all the boxes when it 

comes to playing nicely with macOS. It pulls in 

Reminders and Calendar events and it has 

extensions, a Today widget, and Shortcuts actions. 

It makes it easy to see what you need to do today, 

while allowing you to share tasks (albeit not as 

elegantly as Microsoft ToDo). It appears expensive, 

partly because it charges separately for iPhone 

and iPad apps, but when you add up the prices of 

the other apps here that charge a subscription or 

have in–app purchases, it compares favorably. 

In a nutshell, Todoist is a great option if you 

need to work on non–Apple devices or work with 

others who do. And if budget is an issue, GoodTask 

is the one for you because it provides great 

features and we really like it’s board view. We found 

that 2Do is great for working with hundreds of 

different tasks, while OmniFocus is ideal for those 

invested in the GTD method. And finally, if you 

want a free task manager that’s zippy and allows 

you to delegate, Microsoft To Do will more than 

cover the bases. 

T H E  W I N N E R 

Image rights: Cultured Code.
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Image rights: Skylum.

L
uminar Neo is the latest and most 

fully featured member of Skylum’s 

image editing family to date. 

Making extensive use of AI, it aims to 

simplify the process of removing or 

adding elements in an image, editing 

the look and feel of pictures and 

advanced things like relighting scenes 

or adding different skies. Though a lot 

of this is available in one–click modes, 

there’s also a good depth of fine tuning 

and manual control available as well. 

It’s not a photo management app in 

the same way as Lightroom is, but 

fortunately you can work with 

catalogs, folders, and albums. Load up 

an image and go into Edit mode and 

you can access a number of themed 

presets, all of which provide one–shot 

enhancements with an easily 

adjustable amount slider. 

More interesting, however, is the 

extensive Tools section, with over 25 

edit tools grouped by type. Essentials 

covers more conventional things like 

enhancement, details, denoising, and 

also core Develop tools like curves, 

color, optics, sharpness, crop, and 

more. There’s also a remarkably 

accurate Erase tool with brush settings 

and presets for power lines and dust 

spots. We found it to be incredibly 

good at removing all kinds of elements 

from an image. 

THE BEST TOOLS AVAILABLE 

Then comes the Creative section, with 

tools for relighting different parts of a 

picture, changing skies, adding 

atmosphere and sun rays, film grain, 

and more. There’s layer support with 

Photoshop–style layer modes so you 

can bring in other pictures or graphics 

and layer them up, with all tools 

available independently to each layer. 

Many tools also support masking with 

configurable brushes and there’s 

accurate subject detection, which 

comes in handy for the Portrait tools. 

Here, you can edit body shape, face 

lighting, skin smoothness, and the like. 

An Edits list lets you view all the 

Luminar Neo
AI–powered image enhancement
One–off purchase $79, One–year subscription $59  From skylum.com

Needs Intel Core i5 or better, 8 GB RAM or more (16+ GB RAM is recommended), macOS 10.14.6 or higher

Choose to replace a sky 
and it will even be 
updated in any 
reflections.

EDITOR’S
CHOICE
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Image rights: Skylum.

changes you’ve made and tweak or 

remove any of them, regardless of how 

many steps back they are. Pictures can 

be exported in a range of formats. 

Although Photoshop has begun to 

embrace AI for things like subject 

detection, Luminar Neo feels both 

more advanced in what it can do and 

also friendlier in the way it does it, 

especially for amateur or intermediate 

users. The vast majority of the tools 

are things you really need, rather than 

anything gimmicky, and the app’s 

performance is snappy, its results 

accurate and professional–looking. 

Luminar Neo is incredibly powerful 

but also much easier to use than 

similar apps, giving you quick access to 

useful and accurate editing tools — 

whether you’re just sprucing up a dark 

snap or altering the sky and lighting of 

a scene, while blurring your subject’s 

background. Both subtle and sweeping 

changes are possible and you’ll find 

yourself taken with the joy of 

enhancing your images, all for a 

remarkably affordable price. Skylum’s 

roadmap promises new features will be 

added on a rolling basis, which can 

only be a good thing. 

THE BOTTOM LINE. Luminar Neo 

is a superb image enhancer with 

excellent tools — at a brilliant price too. 

HOLLIN JONES

LUMINAR NEO

  Powerful, usable tools

  Incredible AI detection

  Competitively priced

  Excellent results

AWESOME 

Relight faces or 
smooth skin, using AI 
or a manual masking 
brush.
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Image rights: eM Client.

It’s not the most well–known 
email program, but eM Client has 
been around for 15 years, and was 
recently updated to version 9.0 

for both Mac and Windows. The program has 
quite a dense interface, so it’s possibly not 
the best email app for complete beginners, 
but its all–in–one approach makes it a good 
option for people who want to organize their 
email, calendar, and notes.

After installing eM Client, it runs its New 
Account assistant, which works with several 
different types of email account, including 
Microsoft Exchange and Outlook, GMail, and 
POP and IMAP. We had no trouble setting up 
a couple of old non–Apple email accounts 
but, oddly, there’s no option in the New 
Account assistant for iCloud, so we had to 
search around on the eM Client web site 
before accidentally stumbling across 
instructions for iCloud. To be fair, this is 
mainly due to the way that iCloud mail 
works, but a little more help for Mac users 
wouldn’t go amiss here. 

Thankfully, eM Client was very 
straightforward to use once that was sorted 
out, and the app also supports iCloud and 
GMail calendars and contacts, along with a 

eM Client 9.0
Switch up your email routine  
Free (Personal); $49.95 (Pro)  From emclient.com

Needs macOS 10.14 or later

EM CLIENT 9.0

  Includes email, 
calendars, and notes

  Works with many email 
systems

  �Very expensive

  Dense interface

GOOD 

number of other formats. The app’s interface 
is quite similar to that of Apple Mail, with 
three panels that show a list of your 
mailboxes, emails, and conversations, and 
the email that you’re currently reading. 
However, there’s also a useful option to 
display an additional right–hand sidebar that 
provides quick access to your calendar and 
contacts info. This latest version of the app 
also includes features such as the ability to 
create notes, block tracking pixels, and new 
search filters.

All those features come at a cost, though. 
There is a free version for personal use, 
which has a more limited feature set and 
only lets you use two email accounts. 
However, the full version of the app requires 
a Pro account, which costs $119.95 and 
includes all future upgrades, or $49.95 with 
additional paid upgrades. There are also 
discounts for business users that buy 
multiple licenses. That makes eM Client one 
of the more expensive email programs 
currently available, so it will probably appeal 
mainly to business users, but there’s also a 
trial version of the Pro app available.

THE BOTTOM LINE. A powerful app for 
email, calendars, and notes, but more suited 
to business users. CLIFF JOSEPH

It’s a powerful email app, 
but eM Client’s interface 
can get a bit cluttered  
at times.

The New Account Assistant can help you to get started 
and works with a variety of email systems.
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Total War: Medieval II
Once more into the breach, dear iPad
$14.99  From feralinteractive.com

Made for iPhone, iPad, iPod touch  Needs iOS 14/iPadOS 14 or later

Taking over 
Europe was a 
common pastime 
among royalty in 

the Middle Ages, it seems. 
They’re at it again in 
Medieval II, which takes you 
from Merrie England to North 
Africa and Constantinople.

Total War games, with 
their combination of turn–
based strategy and real time 
tactics, suit the touchscreen 
nicely, though they’re 
arguably a better fit for the 
larger iPads. Essentially, you 
send armies out into an 
abstract map to capture 
territory. When they meet 
another army, they fight, and 
the game changes to a view of 

TOTAL WAR: MEDIEVAL II

  Looks and sounds amazing

  Enormous tactical depth

  Few graphics options

  �May struggle on lower–end hardware

EXCELLENT 

Sieges mean 
bringing out the 
big guns.

your army, in which you 
deploy units, set behavior, 
and take direct control to 
take the fight to the enemy.

It’s a big game in terms of 
both size — 4.5GB of storage 
is required — and scope. It’s 
a complete port of the Mac 
game minus the multiplayer, 
and we’re promised an 
expansion pack down the 
road too. Some of the battles, 
particularly those in which 
more than two armies clash, 
can feel enormous, and while 
you can click the lock button 
at any time, it’s not a game 
for a coach journey. Total War 
requires you to focus, and 
battles can go on for quite a 
long time.

It’s not all fighting, 
however, with diplomacy, 
alliances, secret agents, and 
trade agreements all key to 
dominating the map. 

A mere 15 years old, 
Medieval II will work on 
hardware going back to the 
iPhone 6S, and iPads as 
archaic as the 2014 Air and 
Mini. We’d recommend 
playing it on newer 
equipment — the M1 iPad Pro 
we played it on munching 
through the graphics 
smoothly, with occasional 
freezes at the end of turns 
when processing all the AI 
factions’ moves. You can use 
a keyboard and mouse on 
iPad, though it cuts down on 
the game’s portability. The 
streamlining tweaks made to 
the interface this time give it 
the edge over the previous 
release, Rome: Total War. 

THE BOTTOM LINE. The 
biggest Total War yet mixes 
strategic scheming and 
bloody melee. IAN EVENDEN
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Image rights: Studio Obscura.

Obscura 3 has had a major 
overhaul from version 2, 
to account for the larger 
and more powerful 

phones that most of us now use. The 
most obvious change is the new 
interface that has been designed to 
be easily usable with one thumb. The 
app now has five capture modes — 
photo, portrait, video, live, and 
manual —  each with its own set of 
controls so depending on which 
mode you’re in, you’ll see the 
relevant features. 

You can tap to focus anywhere on 
the screen and use grids and 
histograms for framing and level 
feedback, and both exposure and 
white balance controls now use 
press–and–slide to change, which is 
nice and intuitive. Video capture is 
now supported and this also has a 
manual mode, as well as shooting 
with color effects just like stills. 
These are useful rather than garish 
effects, with a range of subtle film–
style color simulations. 

OBSCURA 3

  Use with one hand 

  Good manual control

  Graded video capture

  A moderate learning curve

GREAT 

RAW and ProRAW shooting 
are supported where your 
hardware allows, and there’s 
focus peaking as well as 
seamless zoom lens switching 
when using phones with more 
than one physical lens. There 
are more options for framing, 
with multiple aspect ratios 
supported, and a new Apple 
Watch app that can be used as 
a remote trigger. 

The library interface has 
also been revamped and you 
can swipe directly into it from 
the camera screen, sort 
images using flags or star 
ratings and also edit images 
using cinema–style filters, though 
there are no fine–grained controls 
like exposure or vibrance at present. 
You can also see detailed EXIF 
information about your images and 
you have some flexibility with saving 
and sharing edited images. 

Despite the claims, there is still 
something of an initial learning 
curve with this app, because its 
interface is possibly a little too 
minimal for its own good in some 
ways. With virtually every interface 
element in black or white and icons 
usually lacking labels, it can be 
confusing exactly what each button 
does until you’ve been around it a 
few times. Once you’ve figured it 
out, it’s powerful and does allow 
pretty easy one–handed operation, 

with plenty of shooting options. The 
developers have gone for a one–off 
purchase system rather than in–app 
purchases, which is a better route 
and at $9.99 it certainly offers a 
more professional feature set than 
Apple’s Camera app.  

THE BOTTOM LINE. Obscura 3 is a 
feature–packed camera app for an 
appealing price. HOLLIN JONES

Some controls now support tap and slide to 
alter settings.

Obscura 3
A pro camera app with slick controls
$9.99  From Ben McCarthy, obscura.camera

Made for iPhone or iPod touch  Needs iOS 14.1 or later

The minimal interface is designed 
to be used one–handed, with 

controls via your thumb.
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EDITOR’S
CHOICE

Now that every schoolchild 

in the country has the latest 

iPhone, or at least it seems 

that way, there’s no excuse 

for them to be late to class. Should 

traditional calendar apps prove 

insufficient, Schooly has them covered. 

An organization app shaped around 

the ebb and flow of the school day, 

Schooly syncs across iPhone, iPad, Mac, 

and even Apple Watch using iCloud. 

There’s a contact list for important 

numbers, plans for lessons (including 

which classroom you need to be in) and 

assignments, metadata so you can attach 

images, notes and more to your 

Unpacking is an outwardly 

simple game about moving 

house that is brimming with 

delightful surprises. You 

remove items from boxes and place them 

around a new home, and in doing so 

learn about the occupant’s life.

There are no spoken words or visible 

characters; instead Unpacking tells 

fascinating stories through objects. As 

you unpack, the protagonist’s life unfolds 

through their belongings. The game also 

reflects on love and compromise — in one 

house the protagonist shares with a 

partner, the only wall space for your 

diploma is above the toilet.

Schooly
Take control of your timetable
Free (Pro from $0.49/m, or $12.99 lifetime)  From schoolyapp.school/

Made for iPhone, iPod touch, Mac  Needs iOS 12.2 or later, macOS 11 or later

Unpacking
Life told through simple objects
$19.99  From unpackinggame.com

Made for Mac  Needs macOS 10.13 or later

GREAT 

AWESOME 

You need to input your timetable, including 
subjects, teachers, and classrooms.

Each room is rendered in gorgeous pixel art 
and full of nostalgic details.

homework reminders, and a home screen 

widget that nudges you about what’s 

coming up next.

IAPs are a bit brazen, consisting 

mainly of ways to tip the developer (who 

claims to be a student himself), but a 

subscription to Schooly Pro comes in 

monthly and annual flavors and adds Siri 

shortcuts, the ability to export your work, 

and to customize the app icon. The most 

useful additional feature is probably the 

ability to add due work via an Apple 

Watch, but we think that a subscription is 

far from a necessity.

If you’re struggling to stay on top of a 

workload with just a calendar app, 

Despite the fact that there are no 

timers or scores, Unpacking is pretty 

challenging. Many of the rooms are short 

on space and you soon go from making 

everything look pretty to simply trying to 

make everything fit. Clicking the packing 

boxes to reveal the next item often 

results in groans as you wonder where 

you’ll put the giant stuffed toy that 

emerges, yet you find yourself relishing 

the challenge and laughing, too.

The game injects humor in other ways, 

like when you’re working on the 

bathroom and find a boot packed in with 

the toothbrushes and towels. That ability 

to make you smile is a key strength of 

Schooly might be worth a download. It 

has myriad uses not just for students, but 

for anyone who relies on being in the 

right place at the right time, and knowing 

which piece of work to tackle next.

THE BOTTOM LINE. A really useful 

organization app for students, to assist 

with time management. IAN EVENDEN

Unpacking, yet it also makes you reflect 

on how the ways we live — alone or with 

other people — change over time, and 

how these tales can be told through the 

simple objects we possess.

THE BOTTOM LINE. A superb game 

full of nostalgia, love, and poignancy. 

ALEX BLAKE
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> HARDWARE

CATEGORY PRODUCT WEB PRICE ISSUE

MESH ROUTER Zyxel Multy U zyxel.com $269.99 #163

4K USB–C MONITOR BenQ EW3280U benq.com $799.99 #169

THUNDERBOLT DOCK Brydge Stone Pro brydge.com $239.99 #188

KEYBOARD NuPhy Air75 Wireless Mechanical nuphy.com $109.95 #189

PORTABLE PRINTER Epson WorkForce WF–110W epson.com $299.99 #185

EXTERNAL HDD iStorage diskAshur M2 istorage-uk.com $169 #178

NAS DEVICE Asustor Drivestor 2 Pro AS3302T asustor.com $249 #190

Qi CHARGER Belkin BOOSTCHARGE TrueFreedom Pro belkin.com $129.99 #179

DESKTOP SPEAKERS Audioengine A2+ audioengineusa.com $269 #189

IN–EAR HEADPHONES Beats Fit Pro beatsbydre.com $199.99 #190

SECURITY CAMERA EufyCam 2C (two–pack kit) eufylife.com $239.99 #171

SMART SPEAKER HomePod mini apple.com $99 #176

OVER–EAR HEADPHONES Sony WH–10000XM4 sony.com $278 #193

AIRPLAY SOUNDBAR Sonos Beam sonos.com $449 #187

WEBCAM AnkerWork B600 Video Bar ankerwork.com $219.99 #191

PHOTO PRINTER Liene 4x6 photo printer amazon.com $136.99 #190

PORTABLE BATTERY PACK Zendure SuperMini Lightning zendure.com $64.99 #186

MOBILE DOCK Kensington 8–in–1 USB–C Mobile Hub kensington.com $77.55 #190

OFFICE CHAIR Branch Ergonomic Chair branchfurniture.com $299 #190

iPAD STYLUS SwitchEasy EasyPencil Pro 3 switcheasy.com $59.99 #190

ACTION CAMERA Insta360 Go 2 insta360.com $299 #190

SMART TV PLAYER Roku Streaming Stick 4K roku.com $49.99 #190

PORTABLE DAC iFi Go Blu ifi-audio.com $199 #189

DIGITAL CAMERA Nikon Z fc nikon.com $969.95 #186

Best of the best
Can’t find the hardware or app you’re looking for in our reviews section? Then check 

in here — we’ve highlighted the best in every major category, as voted for by us
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> iOS/iPadOS APPS

CATEGORY PRODUCT WEB PRICE ISSUE

TO DO (PRODUCTIVITY) Things 3 culturedcode.com $9.99 #194

WRITING Scrivener literatureandlatte.com $19.99 #138

EMAIL Spark sparkmailapp.com Free #190

PHOTO EDITOR Pixelmator for iPad pixelmator.com $4.99 #193

VIDEO EDITOR LumaFusion 3.0 luma–touch.com $29.99 (IAPs) #186

CAMERA FiLMiC Firstlight filmicpro.com $7.99 #164

RSS READER Reeder 5 reeder.app $4.99 #176

IDEAS ORGANIZER OmniOutliner3 omnigroup.com Free (IAPs) #141

NOTE–TAKING Notability 10 gingerlabs.com $8.99 #174

MIND–MAPPING MindNode 7 mindnode.com $14.99 #184

DOCUMENT SCANNER Genius Scan 6.0 thegrizzlylabs.com Free (IAPs) #182

CALENDAR Fantastical 3 flexibits.com $4.99/month #166

WEATHER Carrot Weather 5 meetcarrot.com $0.99/month #180

> macOS APPS

CATEGORY PRODUCT WEB PRICE ISSUE

TO DO (PRODUCTIVITY) Things 3 culturedcode.com $49.99 #194

WRITING Ulysses 21 ulysses.app $49.99/year #177

EMAIL Spark sparkmailapp.com Free #190

PHOTO EDITOR Luminar Neo skylum.com $79 #194

VIDEO EDITOR Final Cut Pro apple.com $299.99 #124

SCREEN CAPTURE ScreenFlow 9 telestream.net $129.00 #164

MUSIC CREATION Logic Pro X apple.com $199.99 #141

PASSWORD MANAGER LastPass lastpass.com From $3/month #188

DESKTOP PUBLISHING Adobe InDesign adobe.com $20.99/month #162

BACKUP Carbon Copy Cloner bombich.com $39.99 #136

VIRTUALIZATION Parallels Desktop 17 parellels.com $79.99 #187

TIME–TRACKING Tyme 3 tyme–app.com $3.99/month #169

VIRTUAL PRIVATE NETWORK NordVPN nordvpn.com $11.95/month #186
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print to a printer on the other side of 
the world, thanks to the internet. 
Nevertheless, and despite 
all the advances in other areas of 
computing, the simple act of printing 
a document or image can be a 
frustrating, hair–tearing experience. 

Whether it’s a printer that your Mac 
just won’t connect to, or one that 
refuses to print within the boundaries 
and parameters you set, there seems 

to be no end to the number of different 
problems printers can encounter. And 
that’s before we even get to the final 
printed image not looking anything 
like the photograph on your Mac. 

Fear not, however. We have the 
solutions here. From setting up a 
printer with your Mac for the very first 
time, to doing more demanding 
printing, you’ll find all the 
answers you need in the pages ahead. 

FOR AS LONG as the Mac 
has existed, there has 
been a way to output 

from it to paper. For a while, Apple 
even made its own printers, 
connected by the now long–
forgotten serial and SCSI ports, 
depending on the device in question.

Now, you’re much more likely to 
connect to a printer wirelessly, or over  
an Ethernet network. You can even 

Master printing on your 
Mac, iPhone, or iPad

Setting up a printer is a whole lot more straightforward  
these days. Here’s how…

WRITTEN BY KENNY HEMPHILL
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Setting up a printer is so much easier than it used to be…

EXPLAINED… The Printers & Scanners interface

PRINTER LIST
Printers connected 

to your Mac are 
listed here. The one 
at the top of the list 

is the default.

SHARING
Printer sharing 
allows other 
computers on your 
network to share a 
printer that’s 
directly connected 
to your Mac. 

IP ADDRESS
You can easily 

connect to a printer 
anywhere on 

the internet by 
adding its IP address 

right here. 

QUEUE ORDER
Clicking Open Print 
Queue displays the 
print jobs currently 
in the queue 
in order.

SETTING UP A printer is 
so much easier than it 
used to be… not so long 

ago, connecting a printer to your Mac 
for the first time was a pain. 

You had to install drivers from a 
disk or download them from the web 
and then hope that your Mac 
recognized the printer. Nowadays, 
thanks partly to the wonders of 

AirPrint, it’s simple. Once you’ve 
connected your printer to your 
wireless network, which often 
means no more than pushing a 
button labelled “WPS” on the printer 
and your router, your Mac will 
recognize its presence then 
download and install the drivers.  

Of course, you can still connect a 
USB printer to your Mac and use 

that, and your Mac will install the 
correct drivers. And you can use a 
wired network with a printer 
connected, too. 

The process is pretty much the 
same, whether you are hooking up a 
regular A4 inkjet, a specialist label 
printer, or a large photo printer. It 
should, to coin a well–worn phrase, 
just work.

Set up a printer on Mac
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The options in the print dialog 
box are dependent on the driver 
software for the printer. 



HOW TO Set up and use a printer with your Mac

4Print in application
Open the document you want to 

print in the application you used to 
create it. Go to File > Print, or press 
Cmd+P. To print every page on your 
default printer with its default 
settings, just click Print.

1AirPrint printer
If your printer has a display panel, 

use that to locate settings and choose 
your Wi–Fi network, then enter 
the password. On a WPS printer, press 
the WPS button and then do the same 
on your router to connect the printer.

7View more settings
To change the paper type or the 

print quality, click More Details under 

the Preview. Click Paper Quality and 

choose the type of paper that is in your 

printer. Use the Quality slider to specify 

the quality of the print you want.

5Configure printing
To print to a different printer, 

click the Printer menu and choose one 
or Add Printer to add a new one. To 
change preset, click the Presets menu 
and choose one. Type a number in the 
Copies box if you want more than one.

2 USB printer
Plug one end of a USB cable into 

the printer and the other end into 
your Mac or hub. Once it’s connected, 
switch the printer on. Your Mac should 
recognize the printer and, if it needs 
to, download the correct drivers.

8Print odd pages
To print only odd, or even, 

pages, click More Details > Media & 
Quality and choose Paper Handling 
from the menu. Click the Pages to 
Print menu and choose either Odd, to 
print odd–numbered pages, or Even.

9Choose a layout
If you’re printing a folded 

document, click More Details then 
Layout from the Media & Quality 
menu. Choose the number of pages 
per sheet and then select a layout. 
Choose other options as required.

6Print specific pages
If you don’t want to print every 

page, you can view different pages by 
clicking the arrow above the preview. 
When you know the page numbers 
you want to print, click From and input 
the page range to be printed.

3Bluetooth printer
Follow the instructions in your 

printer’s manual to put the printer 
into pairing mode. Once it’s in pairing 
mode and close to your Mac, launch 
System Preferences > Bluetooth, click 
on the printer and click Connect.
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Print more quickly and more productively with these advanced techniques
Advanced printing tips

Some printer drivers allow you to 
check how much ink is left in 
their cartridges.  

ONCE YOU’VE MASTERED 

the basics of printing 
from your Mac, there is 

plenty more you can do. From 
printing lots of documents from 
lots of applications without having 
to manually open each one, to 
customizing presets so that you 
don’t have to configure each print 
every time.

Depending on the printer you’re 
using, there are plenty of tools and 
options for getting more out of it. 
For example, most printers these 
days allow you to check how much 
ink is left from the Printers & 
Scanners pane in System Prefs. Just 
choose your printer and then click on 
a button labelled Options & Supplies. 
And most have a built–in web page 

1Print from the Dock
Go to System Prefs > Printers & 

Scanners. Drag a printer from the 
sidebar to the Dock. Now, when you 
print a document using the default 
settings, just drag it onto the printer 
icon in the Dock and it will print.

2Print multiple items
In Printers & Scanners, choose a 

printer and click Open Print Queue. 
Drag and drop the documents you 
want to print onto the Print Queue 
window. Your Mac will open each in 
the correct application and print it.

3Print from Spotlight
Click the Spotlight icon in the 

menu bar and search for the 
document. When it appears in the 
Spotlight results, click on it and drag it 
onto the printer icon in the Dock you 
added. It will open and start printing.

HOW TO Print documents quickly

you can visit to find out more 
information about their status. 

In this section, we’ll show you 
how to get more from your printer, 
and how to print from an iPhone or 
iPad. And you don’t even have to 
print to a printer, macOS has long 
allowed you to save any document to 
PDF, which can be handy for sharing 
it later. 
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1Save as PDF
If you need to make PDFs, using 

Print is quick and easy. Press Cmd+P 
to print your document and click on 
the PDF menu. Choose “Save as PDF”. 
In the next window, choose where to 
save the PDF and click Save.

1Create a preset
Click File > Print and choose More 

Details. Choose the options you want 
from the Media & Quality and Paper 
Type menus and set the Quality. When 
you’re done, click Presets and Save 
Current Settings as a preset.

2Create a shortcut
Go to System Prefs > Keyboard 

and click Shortcuts. Click on App 
Shortcuts > All Applications. Click the 
“+” and type “Save as PDF” in the 
Menu Title. Click in Keyboard Shortcut 
and add your shortcut. Click Add. 

2Use a preset
Click File > Print or Cmd+P. Click 

More Details. From the Presets menu, 
choose Show Presets. You’ll see a list 
of presets, including the one you have 
just created. Click on one, then click 
OK. Click Print to use the preset.

3Use your Shortcut
Open the document you want to 

see as a PDF. Click the keyboard 
shortcut you created. Choose where 
you want to save the PDF and click 
Save. It’ll save you a couple of mouse 
clicks and speed up PDF creation.

3Edit a preset
Edit any preset by choosing it 

from the menu, then instead of 
pressing Print, adjust the settings and 
click the Presets menu again. Then 
choose Save Current Settings and 
give the preset a new name.

> PRINTING FROM iPHONE AND iPAD

Easy printing on your other Apple devices

AirPrint didn’t just change printing on the Mac for the better, it made it possible 
to print from your iOS device without any additional apps or workarounds. All 
you have to do to print from an iPhone, iPad, or iPod touch app is tap the Share 
button and choose Print. You’ll see a print window on–screen from which you 
can choose options, such as the number of copies and which pages to print, and 
then tap Print. And you can even cancel a print job. Just swipe up to see the 
App Switcher, tap the Print Center, and then tap Cancel.

HOW TO Save to PDF

HOW TO Customize presets
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Email Mac|Life at ask@maclife.com
TECH SUPPORT & TECHSPLANATIONS

ASK
If you see this or a similar error when trying 

to install an older version of macOS, it means 

one or both of two things. If you downloaded 

the installer before the end of October 2019, 

its Intermediate security certificate will have 

expired, making it unusable. You’ll need to 

download a newer copy from Apple. In any 

case, recent versions of macOS take 

exception to you wanting to install most 

older versions, and the only way to do that is 

when started up from an external bootable 

installer, such as a USB flash drive or a 

partition on an SSD.

In Disk Utility, format it in HFS+, which is 

essential if it’s to work. Follow the 

instructions given by Apple at bit.ly/

ml194macosinstall to turn that into a 

bootable installer disk. To start a T2 Mac 

from that, first restart it in Recovery mode 

and enable it to boot from external disks in 

Startup Security Utility, then restart your 

Mac holding the Opt key to select the 

external drive. None of this can work on 

M1 Macs, of course, as they can’t run any 

version of macOS before Big Sur, even as 

a virtual machine.

> Safe install of macOS 10.14
I want to install macOS Mojave on an external drive, but can’t run its installer in Monterey, 

as it’s supposedly damaged. Where can I get an intact copy? 
Unruly 
snapshot

Our resident genius solves  
your Mac and iOS problems

EXPERT 
ADVICE

SOMETIMES SNAPSHOTS 

TURN out to be larger 
than expected and free 
space shown in the 
Finder falls worryingly. 
Although this should be 
managed automatically, 
it can cause alarm and 
block necessary 
installations and 
updates. The Storage 
view of About This Mac 
may not be helpful, as 
this gets lumped into 
System Data, and only 
Disk Utility gives an 
accurate picture.

While we can save 
space in backups by 
excluding large files like 
virtual machines, a 
snapshot copies the file 
system for the whole 
volume, including 
everything we don’t want 
backed up. It grows larger 
the longer you leave it, so 
forgetting to hook up 
your notebook’s backup 
disk for a couple of days 
can soon steal tens of 
gigabytes. So, moving 
those files to a separate 
excluded volume spares 
you that overhead, and in 
APFS comes almost  
cost–free. Phew! 
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Although this Mojave installer’s signature seems OK, Monterey claims it’s too old to be used.
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Over the last few months this has 

troubled many using iCloud and may 

have been caused in part by server 

problems. Check that status is green 

for the iCloud services you’re using 

at bit.ly/ml194sysstat. If any of your 

devices have system updates 

awaiting installation, do that next.

Check your iPad and other devices 

have accurate times set in Settings > 

General > Date & Time, which should 

set them for the correct time zone. 

While you’re in Settings, check all are 

signed into the same iCloud account, 

that you haven’t exceeded its 

storage limit, and that each service 

you want to sync is enabled.

Although you can sign out of 

iCloud, it’s simpler to shut each 

device down, wait a couple of 

minutes, then start them up one 

at a time, allowing time for each to 

sync before moving onto the next. 

If Contacts or Calendars are affected, 

you can refresh them: for Contacts, 

open the app and swipe down on its 

list; in Calendars tap the Calendars 

tab then swipe down on the list.

If you have a Mac which is left 

running all the time, there’s a more 

permanent solution for when devices 

are connected to the same network; 

run a Content Caching Service on 

that Mac, by going to System Prefs > 

Sharing and check marking Content 

Caching. If that caches All Content, 

that includes system and app 

updates and much of the data shared 

using iCloud.

> Faster iCloud syncing
Sometimes working documents take an hour or two to sync across my devices. How can I 

speed up iCloud syncing from my iPad?

Quick–fire 
questions 
& answers
WHY IS MY iPHONE 13 

PERSONAL HOTSPOT 

UNRELIABLE?

Older devices may not 
support its 5GHz Wi–Fi 
frequency, or there could be 
interference. iPhone 12 and 
later models offer optional 
2.4GHz Wi–Fi compatibility 
in Settings > Personal 
Hotspot, although Apple 
warns internet performance 
and Wi–Fi security may not 
be as good.

KEEP GLASSES 

ON FOR FACE ID?

That depends on whether 
their glass blocks infra–red, 
required by Face ID cameras 
for recognition to work. If 
they do, remove your 
glasses before setting up 
your appearance, or add an 
alternative appearance if 
you prefer. Otherwise they 
should make little 
difference, so use 
whichever is more likely 
when you’re unlocking  
your device.
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Check you haven’t exceeded your iCloud storage limit, 
and the services you want to sync are enabled.
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iCloud isn’t suitable for making proper 

backups of your Mac, but is valuable for 

keeping off–site copies of files provided you 

don’t rely on always having instant access. 

It isn’t guaranteed to be available.

When you put files in iCloud Drive, 

they’re copied up to the iCloud servers, but 

the original also remains on your Mac. If the 

copy in iCloud changes, by editing it using a 

different Mac or device, that’s synced back 

to your Mac, keeping it up to date.

Behavior changes if you enable Optimize 

Mac Storage in System Preferences > Apple 

ID. That lets macOS decide when to “evict” 

files from local storage, leaving only a stub 

on your Mac. 

The Finder then marks those with a cloud 

and downward arrow icon. So long as 

there’s ample free space on your Mac’s 

storage, that process normally only 

happens with files you haven’t accessed 

recently, but if local storage gets tight, 

macOS can evict more. Once evicted, you 

can still use the file, but it has to be 

downloaded from iCloud first.

If that method doesn’t meet your 

requirements, you can keep additional local 

copies, but you’ll then have to work out how 

to keep them in sync with those in iCloud 

Drive. Obviously, you don’t have to enable 

optimization, but macOS seems only too 

keen that you do.

> iCloud for off–site copies
Every month I copy my important folders to an external drive. If I 

were to do this using iCloud, would I also need to keep local copies?

WHY DO I NEED  

WI–FI WHEN MY MAC  

HAS ETHERNET?

Macs use Wi–Fi and 

Bluetooth for connections 

with Handoff and Continuity. 

These include AirDrop, 

Universal Clipboard, 

unlocking with an Apple 

Watch, and iCloud Tabs in 

Safari. When you want 

Ethernet used in preference, 

drag it to the top of the list 

in the Network pane.

SHOULD MACS USE  

DHCP ADDRESSES  

FROM MY ROUTER?

DHCP works best for visitors 

such as laptops and iPhones 

rather than more static 

systems. Fixed devices like 

printers are best assigned a 

fixed IP address, saving them 

having to renew leases. 

Configure this in the DHCP 

section of your router’s set–

up page.

Items evicted to iCloud are distinguished by the cloud icon, and exist locally as small stub files.
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> Missing Network Utility
What has happened to Network Utility in Monterey?

Network Utility, which has been tucked 

away in the CoreServices folder of the 

macOS System volume, is now a shadow 

of its former self. When you run the app 

it just tells you that Apple has removed 

its functionality in Monterey. To “ping” 

other sites, use the ping command in 

Terminal, or a substitute app.

Commands like ping aren’t hard to 

use: to ping Apple’s main web servers, 

use the command

ping apple.com
for example. Other easily used 

commands include netstat, whois and 

traceroute, each of which has many 

options. Those are fine if you’re happy 

using Terminal, but most will want a 

proper app, like the donationware 

WhatRoute from whatroute.net. Its 

latest version now incorporates ready 

access to the networkQuality command, 

saving you from having to use Terminal.

Even though your Mac may connect 

primarily over a wired Ethernet 

connection, it’s likely to have its Wi–Fi 

turned on to support Handoff and 

Continuity features. In that case you 

can hold the Option key down, click on 

the Wi–Fi item in the menu bar and Open 

Wireless Diagnostics to test its Wi–Fi 

connection, and provide an expert 

opinion. But it’s no substitute for 

Network Utility.

https://whatroute.net/


Network Utility just tells you it has been “deprecated”, 
so use WhatRoute to “ping” internet servers and more.
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WHICH ETHERNET 

ADAPTOR FOR MY 

M1 MACBOOK PRO?

There’s no difference in 

network speeds achieved by 

plain USB–C and more costly 

Thunderbolt models. If your 

Mac has only two 

Thunderbolt ports, look for 

an Ethernet adaptor with 

USB–C charging pass–

through, additional ports 

such as USB, or a buy a 

smaller mini–hub, for  

greater flexibility.

HOW TO TELL IF MY  

OLD MAC MINI  

SUPPORTS AIRDROP?

Opt–click the Apple menu 

and select System 

Information…. Then, select 

Wi–Fi in the Network section, 

where it should tell you 

clearly whether AirDrop is 

supported, and its current 

channel number.

NetworkQuality is a new command tool in 

Monterey which measures the speed and 

quality of transfers with Apple’s test service 

at apple.com. If your Mac can’t upload to or 

download from that server, its results will 

be zeroes, but you then have the 

troublesome and confusing task of 

discovering where exactly that failure  

has occurred. 

If you can reach other sites such as 

apple.com/us, it’s likely Apple’s test server 

is down; try again later. If other sites are 

unreachable, use troubleshooting drills such 

as checking your router’s configuration and 

restarting it. One quick fix that sometimes 

works is simply restarting your Mac, which 

initializes network hardware and loads the 

drivers afresh.

> Network quality zero
Twice today I ran networkQuality and it returned all zeroes. How can I tell what’s wrong?
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Tracing the route to a server 
using WhatRoute can also 
show speed bottlenecks 
affecting performance.

https://www.apple.com
https://www.apple.com/uk/


Try rebuilding the Spotlight indexes on that 

drive. With the disk connected and mounted, 

go to System Prefs > Spotlight > Privacy. 

Using the “+” tool add the whole drive to the 

list and close the pane. After a few moments, 

open System Prefs’ Spotlight pane again, 

select the disk or volumes and use the “–” 

tool to remove them. Leave the drive 

connected for two hours at least, during 

which you can observe the reindexing taking 

place in the CPU tab of Activity Monitor.

Processes whose names start with md like 

mds_stores and mdsworker should then use 

plenty of CPU until their task is complete and 

the new indexes are ready to use. In versions 

of Monterey prior to 12.3, the Finder’s Find 

command, but not Spotlight itself, also has a 

serious memory leak which you’ll want to 

work around. As you search for different 

terms, the Finder will use more memory, 

which it only returns when you restart it. If 

you want to look for files, Find Any File from 

the App Store is much better, and 

HoudahSpot is best for general content.

> Can’t find any file
After recent macOS updates, using the Finder’s Find command has failed to locate 

files on the external disk containing my archives. How can I get it working?

WHERE CAN I FIND 

PYTHON IN MONTEREY?

Before macOS 12.3, Python 

2.7 has been included in the 

normal macOS distribution. 

That changes in 12.3, where 

it has been removed, and 

Python 3 has to be installed. 

Universal installers are 

available from bit.ly/

ml194python and elsewhere.

HOW TO STOP LID 

OPENING BOOTING AN M1 

MACBOOK PRO?

Unless Apple provides an 

option to allow you to open 

an M1 notebook without it 

starting up, there’s no way 

to do that. So, don’t put 

anything thicker than the 

paper used by Apple to 

cover the keyboard between 

that and the display. 

Local snapshots made by Time 

Machine as part of backing up are 

different from its backups. That’s 

because snapshots include every file 

and folder on the volume, thus can’t 

and don’t exclude those items which 

you or macOS exclude from backups.

A snapshot consists of a complete 

copy of the file system for an APFS 

volume at an instant in time. That 

includes many files which Time 

Machine’s defaults don’t include in its 

backups, such as the hidden database 

of document versions and what’s in the 

Image rights: Apple.

> Huge snapshots for small backups
Why are Time Machine’s hourly snapshots so huge when it’s only backing  

up my Documents folder, and those backups are far smaller?

Old kernel extensions such as this supporting 
HP printers should be removed from the 
Extensions folder in the main Library.

Trash. After that snapshot is made, 

when the data for any of those files 

changes, or a file is deleted, the old 

data is kept so that you can restore the 

whole volume or any file from it. 

Snapshots therefore grow over time, as 

they collect all that changed data.

Time Machine backups only contain 

what you want backed up. So you could 

build an exclusion list which results in 

just one folder on a volume being 

backed up each time, but the whole 

of that volume will still be retained in 

local snapshots.

If you’ve got large files which change 

a lot, like virtual machines, you could 

store them in separate volumes on the 

same storage and add the whole 

volume to Time Machine’s exclusions. 

Then that volume won’t have 

snapshots made, although that means 

you’ll have to use a different way to 

back them up instead of Time Machine.

Time Machine’s hourly 
snapshots include the whole 
volume, while its backups can 
be more limited in their scope.
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> Backup exclusions
Is there a better way to exclude individual files from Time Machine backups? To Monterey?

If you don’t want to move files to 

volumes which aren’t backed up at 

all, it’s simplest to add them or their 

enclosing folders to the exclusion list 

accessed using the Options button in 

the Time Machine pane. There’s 

another method available in Terminal 

using the command

WHERE TO GET A STANDALONE 

UPDATER FOR 12.2.1?

Apple doesn’t provide downloadable 

standalone updaters for Big Sur and 

Monterey. Updates are now installed 

differently, and can’t use Installer 

packages. You can download and 

install the update using System Prefs’ 

Software Update pane, or download 

the installer app from the App Store. 

HOW TO START UP AN M1  

MAC IN SAFE MODE?

Do this through Recovery. Shut your 

Mac down, leave it, then start it up 

and keep the Power button pressed 

until it says it’s loading Options. 

Select the disk you want it to boot 

from in Safe mode, press and hold 

Shift and click Continue in Safe Mode. 

Then, the Mac restarts in Safe mode.

Image rights: Apple.

tmutil addexclusion
That has three variations: option 

-v excludes whole volumes 

referenced by their UUID; option -p 

excludes folders and files by their 

path, and no option (the default) 

excludes individual files and folders 

by marking them with an extended 

attribute. macOS also has its own 

standard list containing mostly 

hidden folders such as Spotlight 

indexes and Trash folders, but 

you can’t alter that.

Those are now listed in the  

hidden file  

.exclusions.plist in each backup.

Backup exclusions you set in the Time Machine pane 
are detailed in a hidden file in every backup saved.
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THE MUCH–DELAYED Universal 
Control finally rocked up in 
March 2022. It builds on 
Sidecar, which can turn your 

iPad into an extra Mac display, but this 
time it keeps the iPad as an iPad: it 
enables you to connect an iPad or Mac and 
control them with the same keyboard and 
mouse, and you can also drag and drop 
between them. It feels a bit like magic.

Master Universal Control
Control everything on your iPad with your Mac

In order to use Universal Control, you’ll 
need to take care of a few things first. The 
iPad or Mac you’re adding must be 
running the latest iPadOS or macOS, 
which at the time of writing is iPadOS 15.4 
or macOS 12.3. Your devices all need to be 
logged into the same iCloud account. And 
unless you’re connecting an iPad via USB 
you need to have Bluetooth, Wi–Fi, and 
Handoff enabled; those things are all on 
by default but you can check on your iPad 
in Settings > General > AirPlay & Handoff.

As we’ll discover, it’s a very easy 
process to set up Universal Control and it 
works brilliantly. But it’s also important 
to know that there are a few limitations 
too. Mac trackpad gestures don’t 
currently work on iPad over Universal 
Control, and if you’re dragging things to 
your iPad you need to be dragging them 
into an open app — so for example if 
you’re dragging an image across you’d 
need to drag it and drop it onto Photos, 
not on the Home Screen.
CARRIE MARSHALL

REQUIRES
macOS 12.3 and  

iPadOS 15.4 

YOU WILL LEARN
How to control your iPad 

with your Mac

IT WILL TAKE
5 minutes

IT’S VERY 

EASY TO SET 

UP UNIVERSAL 

CONTROL AND 

IT WORKS 

BRILLIANTLY

Universal Control enables you to work your iPad just 
as though it was a Mac, so here we’re Ctrl–clicking on 
the Safari icon to see all its options.

CREATE

78   JUN 2022

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

Image rights: Apple.



HOW TO Set up Universal Control 

Add your device
Click on the Add Display drop–down at 

the lower left of the Displays window. This will 

give you a list of available devices, and it’s in 

two sections: “Link Keyboard and Mouse” is 

the one we want here.

Relocate the device
If you’d rather have your iPad or 

second Mac in a different position, no problem: 

you can simply drag the screen position to 

whatever location you prefer. Here, we’ve 

put our iPad to the left of our Mac.

Move it around
The Displays window will now show two 

screens: your Mac’s, and the iPad or Mac 

you’ve added. By default the new arrival sits to 

the right of the main display so to move your 

cursor across just keep moving to the right.

Change the role
If you’d rather use your iPad as an 

extended display, where it acts as an extra bit 

of your Mac desktop instead of a remote 

controlled iPad, you can change its role in the 

same window: just click Display Settings.

 
JARGON BUSTER

Handoff is Apple’s 
technology for moving 
seamlessly from device to 
device, so you might start 
on your phone or iPad and 
continue on your Mac.

 
GENIUS TIP

 
In Universal Control 
settings, check mark the 
“Automatically Reconnect 
to Any Nearby Mac or 
iPad” box so you don’t 
need to set up your device 
every time.

Select the device
With macOS 12.3 installed on your Mac, 

go to the Apple menu > System Preferences > 

Displays. In this tutorial we’ll work with a solo 

MacBook Pro, but Universal Control is still 

available if you also have an external display.

Choose your control
Click on Universal Control to see these 

options. For best results, you’ll want to ensure 

that the first two are both checked. This 

enables you to move seamlessly between 

devices that share the same iCloud account.

How to do anything on your Mac, iPhone & iPad
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Select the files
Locate the files you want to rename in 

Finder. Cmd–click on each file. Then, when 

you’ve selected all the files you want to 

rename, Ctrl–click on them and choose 

Rename, or click File > Rename.

Replace Text
In the dialog that appears, choose 

Replace from the menu. In the left–hand box 

next to Find, type the text you want to replace 

in the name of the file. For example, “DSC” in 

the name of a photo.

 
GENIUS TIP

If you need more options 
than the Finder offers, 

there are third– 
party tools. One of those 
is the venerable A Better 

Finder Rename.

HOW TO Batch rename files in the Finder

THERE ARE MANY reasons 
why you might find yourself 
needing to rename lots of files 
at the same time. Perhaps 

you’ve transferred photographs or videos 
from a memory card and want to be able 
to identify them better, or organize them 
by date, location, or occasion. Or perhaps 
you’ve used a disk recovery tool to 
retrieve data from a failed drive and want 
to quickly organize the files that you’ve 
saved from permanent deletion. Whatever 
the reason, until a few years ago, there 

Rename multiple files
The Finder in macOS allows you to rename files in batches. Here’s how…

was no way to do it without using a 
third–party tool or writing your own 
script or Automator action. 

In OS X Yosemite, however, that 
changed with the introduction of a 
renaming tool in the Finder. But it’s one 
of those features that gets little attention, 
so many Mac fans don’t even realize it 
exists. You can use it to replace text in a 
file name, append text to a filename, or 
replace a whole filename. We’ll show you 
how to use it to rename groups of files in 
different ways. KENNY HEMPHILL

REQUIRES
OS X 10.10 or later

YOU WILL LEARN
How to rename lots of 
files at once in Finder

IT WILL TAKE
30 minutes
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Finish replacing text
In the “Replace with” field, type the 

text you want to replace the text typed in the 

Find entry. Note that it will be used in multiple 

files, so shouldn’t be too specific. Click 

Rename to replace the text in the filenames.

Format the name
The Format option enables you to 

replace all the text in a filename with new text 

and a number. The text is the same for all files, 

while the number increases by one for each 

file. Choose Format from the menu to use it.

Finish formatting
Choose where the index, date, or 

counter should go, type the name into Custom 

Format, and type a number in the “Start 

Numbers at” box if you’ve selected Name and 

Index or Name and Counter. Click Rename.

Add Text
If you want to add text to the filename, 

rather than replace existing text, choose Add 

Text from the menu. Type the text you want to 

add, then choose “before name” or “after 

name” from the menu and click Rename.

Choose an option
Choose one of the options from the 

Name Format menu. Name and Index, which 

adds an integer, Name and Counter which adds 

“0000” before the integer, or Name and Date 

which adds the date and time after the name.

Undo the rename
If you realize that you’ve made a 

mistake after you click Rename, or if you 

change your mind when you see the results, 

choose Finder > Edit > Undo Rename. Or press 

Cmd+Z to undo the most recent change.

 
JARGON BUSTER

The benefit of using 
Counter rather than Index 
is that the option ensures 
files are sorted in 
numerical order by 
all apps.

 
GENIUS TIP

If you want to remove text 
from file names rather 
than replace or add to it, 
use the Replace Text 
option and leave the 
Replace box blank.
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AS CONVENIENT AS macOS is, 
sometimes it could be a bit 
more convenient: who wants 
to look down at the keyboard 

to remember which key fires up 
Launchpad or shows the Desktop or app 
windows? And what if you’d rather 
activate the Notification Center from the 
top left of your screen rather than the top 
right? Luckily, Hot Corners is here to help 

Work fast with Hot Corners
Hot Corners in macOS can make your everyday tasks quicker 

by making it even faster to access useful 
system features. In this tutorial we’re 
using macOS Monterey, but Hot Corners 
is available in older versions of macOS 
too; the feature was introduced more than 
10 years ago and it’s been a staple of 
macOS ever since.

Hot Corners lives in System Preferences 
> Desktop & Screen Saver > Screen Saver 
or in System Preferences > Mission 
Control and it enables you to set specific 
actions that will run when your mouse or 
trackpad reaches the appropriate corner. 
On Monterey one of them is already set 
up; if you move your mouse or trackpad 
cursor to the very lower right, the Quick 
Note will then appear in the corner. In 
addition, you can change this to 
something else, such as displaying the 
desktop, putting the display to sleep, 
showing the available app windows 
or bringing up the Lock Screen. 

Hot Corners works on multiple 
displays, but it works as if your MacBook 
and external display are one huge 
monitor, so that means the top corners 
are on the monitor and the bottom on the 
MacBook. CARRIE MARSHALL

REQUIRES
macOS

YOU WILL LEARN
How to set up mouse–

enabled shortcuts in the 
corners of your screen

IT WILL TAKE
5 minutes

You can add modifier keys so Hot Corners don’t 
activate when you don’t want them to.

 
GENIUS TIP

When you create a hot 
corner, you can press a 

key such as Shift as you 
select its action. The 

corner won’t activate if 
that key isn’t pressed.
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Test the corner
Let’s try that one first. Move 

your mouse or trackpad cursor to the 

lower right of your screen and you 

should see a Quick Note corner appear. 

If you keep the cursor there or click, 

the note will open up for you to edit.

Open Preferences
Hot Corners is in System 

Preferences > Desktop & Screen Saver, 

and it’s also in System Prefs > Mission 

Control, too. It doesn’t matter which 

one you choose: they’ll both take you 

to the same options.

Test it out
Here, we’ve made the top–left 

corner show current application 

windows, in this case for Safari; 

moving the cursor into the top left 

temporarily hides everything but the 

currently selected app’s windows.

Change the corner
You don’t have to stick with 

Quick Note here. Click the menu for 

the lower–right corner to see more 

options including screen saver options, 

Mission Control and Launchpad, and 

some display options too.

Find the button
If you went for the Screen 

Saver option, you’ll need to click the 

Screen Saver button. You should now 

see the Hot Corners button at the 

bottom right. If you went the Mission 

Control route, it’s at the bottom left.

Disappear desktop
Now, we’ve assigned Desktop to 

a Hot Corner; moving over the corner 

hides the apps so that we can see 

what is currently on our desktop. With 

dual displays this shows the desktop 

for the display with the Hot Corner.

Launch Launchpad
In this example, we’ve chosen to 

activate Launchpad from our Hot 

Corner, providing quick access to all 

our apps and to the Dock too. It’s a 

great example of how Hot Corners can 

make your Mac more you.

Add some more
Now make your way around the 

other corners to add more Hot 

Corners. If the menu shows a dash 

(“–”) it means that corner isn’t active 

as a Hot Corner. You can disable any 

Hot Corner by choosing that option.

See what’s set up
When you click the Hot Corners 

button you’ll see a pop–up window with 

four menu selections. On Monterey, 

the bottom right one may already be 

filled in with the Quick Note feature, 

which is allocated to the bottom right.

HOW TO Use Hot Corners on your Mac
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APPLE DOESN’T JUST give you 
great tools to make creative 
masterpieces. It gives you lots 
of ways to share your creations 

too, and in the case of ebooks you can also 
sell them on Apple Books. All you need is 
a copy of Pages. It’ll take care of the 
publishing so you can concentrate on 
making your book as great as it can 
possibly be.

In this tutorial we’ll show you how to 
publish your own novel, but Apple Books 
is open to all kinds of genres — 

Publish your own ebook
Want to publish to Apple Books? All you need is Pages (and a book)

educational books, children’s books, 
history books… if you can imagine it, 
there’s a place for it in Apple Books. 

We’re going to show you how to publish 
a book that you want to give away for free. 
The process for selling books is much the 
same, but there are a few extra hurdles to 
overcome; because Apple Books is US–
based you need to fill out some Internal 
Revenue Service (IRS) forms. Don’t worry 
though, because Apple will take you step 
by step through this process.  
CARRIE MARSHALL

REQUIRES
An Apple ID, Pages, your 

own transcript

YOU WILL LEARN
How you can publish 

to Apple Books

IT WILL TAKE
20 minutes

HOW TO Publish to Apple Books

Do it in Pages
There are many brilliant writing 

apps for Mac — Ulysses, Scrivener, and so 

on — but when it comes to publishing to 

Apple Books, Pages is hard to beat. 

Create or open your work in Pages and 

select File > Publish to Apple Books.

Prepare to publish
Apple accepts book submissions 

through iTunes Connect, which is also 

used by app developers and it enables 

you to track all your Apple Books titles. 

Pages will launch iTunes Connect, which 

you access using your Apple ID.

Enter your info
iTunes Connect will ask you to log 

in and then it should display this page of 

legalese. Unless you’re publishing books 

on behalf of a company, select Individual 

and enter your name or your pen name 

in the Seller Name section.
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Use the Dashboard
This is the iTunes Connect 

dashboard, and as you can see there are 

multiple icons to access different parts 

of the service. My Books is currently 

empty; before you add anything, go to 

Agreements, Tax, and Banking.

Add book info
iTunes Connect will return you to 

Pages and you should see a message 

asking whether this is a new book or an 

update. The latter enables you to upload 

new versions of books you already have 

in Apple Books, but our book is new.

Set the genre
You need to specify genre 

and sub–genre, such as Fiction and then 

Crime, but your book might be 

educational, a how–to about pets, a 

music book, etc. This affects visibility, 

search results, and any chart placings.

Decide what to do
In this tutorial we’re going to 

publish a free book, so we can just click 

View and “Agree to Terms” here. If you 

want to sell books for money you’ll need 

to provide bank details and fill out some 

tax forms to keep the IRS happy.

Add essentials
This next screen dictates how 

people will find your book and what 

they’ll see. You can add a cover image —

we’d definitely recommend it — as well as 

specify genres and add your book 

description details of any series.

Check your work
It’s important to check your work. 

If you click on the Preview Book link, 

you’ll see a preview of your book exactly 

as it’ll appear in Apple Books; check it 

for mistakes and layout problems 

because reviewers aren’t forgiving.

Add a subtitle
The subtitle is important; it’s the 

text that appears in big letters along with 

your book title, so it’s a useful selling 

tool. If this is the first book in a series, 

such as a detective or fantasy series, you 

can include those details for display too.

Wait to go live
Once you submit your book it’ll 

take a while to be approved — in this 

case, it happened overnight. You’ll then 

get an email from Apple telling you that 

your book is live and giving you a link so 

you can see it in Apple Books. 

Pick your pricing
You have two options here: 

“Offer Your Books for Free”, which is the 

simplest option and the one we’re going 

to use here, or “Offer Your Books For 

Free and Sell Your Books”, which enables 

you to give away books or sell them.

How to do anything on your Mac, iPhone & iPad
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Your first measurement
Open Measure and move the device 

around, following the on–screen instructions. 

Keep moving the device until you see a circle 

with a dot in the center appear on the screen. 

Your device now has its frame of reference.

Take the measurement
Move your iPhone or iPad until the dot 

is over the point where you want to start your 

measurement. Tap the “+” on screen to lock it 

in position. Move your device again until the 

dot is over the end point, then tap “+” again.

 
GENIUS TIP

On devices with a LiDAR 
scanner, tap the three 
lines at the top of the 

screen to see 
measurements you’ve 

taken in the current 
session, including any 

photos taken. 

HOW TO Measure objects in iOS

OF ALL THE built–in apps on 
iPhone, Measure is the one 
that gets the least attention. 
And yet, it’s one of the most 

impressive. It’s also a good illustration of 
how augmented reality (AR) can be put 
to practical use on a mobile device. 

The Measure app enables you to 
measure real–life objects around you 
using the iPhone or iPad’s camera sensors 
to detect edges and corners and then do 
some clever maths to determine the 
distance between them. On more recent 

Measure almost anything
It may be unheralded, but the humble Measure app can be very useful

iPads and iPhones, Measure also uses the 
built–in LiDAR scanner to more quickly 
and accurately determine distances.

As well as measuring the distance 
between two points, Measure can take 
multiple measurements and even 
calculate the area of a rectangle. You can 
use it to work out someone’s height and 
save photos of the measurements to your 
Photos Library. It even has a built–in 
spirit level which, while no substitute for 
a real one, can come in handy for, say, 
hanging a picture. KENNY HEMPHILL

REQUIRES
iPhone or iPad 

YOU WILL LEARN
How to measure real–life 

objects in the  
Measure app

IT WILL TAKE
30 minutes
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Adjust the points
To adjust your measurement, or 

measure another part of an object, tap and 

hold one of the points and drag it to where 

you want it to go. Do the same with the other 

one, if required. The measurement will change.

Save a photo
Once you’ve taken the measurement, 

you can tap the shutter button on screen to 

take a photo of it. You can then tap the 

thumbnail to mark it up, or just wait a moment 

for it to save to your Photos Library.

Undo a measurement
If you make a mistake while taking 

multiple measurements, tap the Undo button 

(top left of the screen) to move back a step. If 

you want to get rid of all the measurements 

on screen and start again, tap Clear. 

Save the measurement
Once you’ve taken the measurement 

you want and are happy with it, tap the 

number and you’ll see it appear on the screen 

in centimeters and inches. Tap Copy to copy 

it to the clipboard and “X” to dismiss the box.

Multiple measurements
After you’ve taken one measurement, 

move the device so the white dot is at the 

point you want to start the next one. Tap “+”, 

then move the device so the white dot is over 

the end point and tap “+” again. 

Measure a rectangle
Move your device so the whole 

rectangle is on the screen. Measure should 

recognize it and display its edges, along with 

their measurements. Tap inside it to display 

the area and length of the diagonal.

 
JARGON BUSTER

Light Detection and 
Ranging (LiDAR) uses 
lasers to measure distance 
and depth to improve 
augmented reality, among 
other technologies. 

 
GENIUS TIP

On devices with a LiDAR 
scanner, when the 
Measure app detects a 
person in the viewfinder, it 
automatically displays 
their height on the screen.
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QUICK LOOK The Apple News interface

APPLE NEWS ON iPhone, iPad, 
and Mac is designed to be a 
one–stop shop for news and 
magazine–style content. It has 

two elements to it: the standard News 
service which is free and enables you 
access to content from publishers like the 
The New Yorker, who allow content to be 
distributed at no cost, and the News+ 
services which costs $9.99/month and 
provides access to absolutely everything. 

Aside from a greater choice of 
publications, Apple News+ enables you to 
read magazines cover to cover and 
download them for offline reading. You 

Discover Apple 
News
Apple’s News app provides 
access to hundreds of 
publications that can be tailored 
to suit you

can share an Apple News+ subscription 
with up to six family members.

Both the standard News service and 
News+ offer stories that are hand–picked 
by Apple’s editors and pushed to your 
feed based on your reading habits and 
preferences you’ve set. You can, for 
example, choose to follow specific 
channels, in which case their content will 
be more prominent in your feed. If you’re 
not happy with the type of content in your 
feed, you can make adjustments so that 
it’s tailored to your personal taste. We’ll 
show you how to do all of that here. 
KENNY HEMPHILL

REQUIRES
iPhone, iPad or Mac; Apple 

News app

YOU WILL LEARN
How to use the 

Apple News app

IT WILL TAKE
30 minutes

TODAY VIEW
The Today view displays 
stories from subscribed 
channels, and those the 

News algorithm thinks you 
might like.

CHANNELS
Channels and topics are 
displayed in the sidebar 
on iPad and Mac, and 
you’ll find them in the 
Following tab on iPhone.

NEWS+
News+ is a subscription 

service that provides 
access to a selection of 

hundreds of newspapers 
and magazines.

SAVED STORIES
You can save stories to 
read later; when you do, 
they are added to 
Saved Stories.
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Manage on Mac
To unfollow or block a channel 

on Mac, Ctrl–click on it in the sidebar 

and choose Unfollow Channel or Block 

Channel. You can also manage blocked 

channels by clicking File > Manage 

Blocked Channels & Topics.

Channels on iOS
Tap News, then tap Following at 

the bottom. Tap the “+” next to the 

channels you want to follow. To see 

more channels, swipe to the bottom 

and tap Discover Channels then again 

tap the “+” on any you want to follow.

Customise 
Notifications

On iOS, tap News > Following, then 

scroll to the bottom. Tap Notifications 

& Email. Toggle channels you want to 

be notified about to on. On the Mac, 

it’s File > Manage Notifications & Email.

Restrict stories
On iOS, to restrict what appears 

in your feed to the channels you 

follow, launch the Settings app and tap 

News. Toggle the Restrict stories in 

Today switch to on. On Mac, it’s News > 

Preferences > Restrict Stories in Today.

Unfollow a channel
Tap Following at the bottom of 

the main screen and then swipe left 

over the channel you no longer want 

to follow and tap Unfollow. You can 

also tap and hold on it and select Block 

Channel to block it from your feed. 

Share a story
On iOS, tap on the story you 

want to share and tap the More button 

(“…”). Tap Share Story, then choose 

how you want to share it and with 

whom. On the Mac, click on the story 

and click the Share icon at the top.

Sign up for News+
On iPhone or iPad, tap the 

News+ button at the bottom of the 

screen, then tap Get Started and follow 

the instructions on screen. On your 

Mac, click File > Manage Subscriptions, 

then tap Subscribe.

Custom 
notifications

Enable notifications. On iOS, go to 

Settings > Notifications > News > Allow 

Notifications. Select other options as 

required. On Mac, it’s System Prefs > 

Notifications & Focus > News. 

Channels on Mac
On the Mac version of News, 

click File, then choose Discover 

Channels. Click the “+” next to a 

channel. You can also search for topics 

in the search bar, and click the “+” 

next to channels in the search results.

HOW TO See the content you want on Apple News
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TO CREATE A more flattering 
portrait, professional 
photographers can manually 
set their Digital SLR camera 

to use a wide aperture. The wider the 
aperture’s f–stop (such as f2.0), the 
blurrier the background will be. This 
background blur is referred to as bokeh. 

A blurry background removes 
distractions and helps focuses the eye on 
the person in the foreground. The 
iPhone’s native Camera app doesn’t allow 

Better bokeh on iPhone
How to add a flattering background blur to your portraits

you to manually adjust the aperture 
setting used when shooting, but it does 
offer a software solution to creating a 
bokeh courtesy of its Portrait shooting 
mode. As a bonus this bokeh can be 
adjusted in Photos to make it blurrier or 
sharper, which is something you can’t do 
if you capture bokeh with a traditional 
camera. We’ll show you how to put 
Portrait mode through its paces and 
adjust the bokeh of the picture. 

Portrait mode produces striking results 
but the iPhone’s software solution to 
creating bokeh doesn’t always work. You 
may notice sharply focused bits of 
background hiding amongst a person’s 
hair. With a natural in–camera bokeh all 
background areas are blurred equally. 

We’ll also show you some classic 
shooting techniques to help you capture 
natural in–camera bokeh using the 
iPhone’s standard Photo mode. These 
examples of bokeh won’t be adjustable in 
Photos but they will be as natural as those 
produced by a DSLR camera. 
GEORGE CAIRNS

REQUIRES
iPhone 7 Plus or later

YOU WILL LEARN
How to add computer–

generated blur, and 
natural in–camera bokeh

IT WILL TAKE
10 minutes

BOKEH 
A bokeh blur reduces 

background 
distractions and 

creates a mix of colors 
to flatter your 

subjects.

INFO 
Click here to access 
info such as the 
aperture value. A 
wider f–stop such as 
f1.8 will indicate a 
blurrier background.

DEPTH 
In Portrait mode, you 
can adjust the bokeh 
strength before you 
shoot, or change it 

afterwards in the 
Photos app. 

LIGHTING 
The bonus of shooting 
in Portrait mode is its 
ability to add studio 
lighting effects to your 
subject.

WITH A 

NATURAL IN–

CAMERA 

BOKEH, ALL 

BACKGROUND 

AREAS WILL 

BE BLURRED 

EQUALLY
By shooting close to a subject using a telephoto lens 
you can create a natural “baked in” bokeh.
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HOW TO Capture a bokeh effect

Post–production 
As the Camera app’s bokeh is 

computer–generated, adjust it in the Photos 

app in iOS or macOS. Go to Edit and adjust the 

Depth slider. A value of f2.0 creates an 

effective bokeh to complement our subjects.

Real bokeh 
To capture a natural bokeh, get your 

iPhone close to the subject. Choose Photo 

mode. Use the Telephoto lens. Tap to focus 

on the subject. The camera’s close proximity 

will ensure a natural background bokeh.

Shooting objects 
Earlier versions of Portrait mode on 

older iPhones could only recognize faces. Now 

you can tap on a face or an object to select 

which subject stays sharp. This gives you more 

creative control over where the blur appears.

Macro 
By placing your iPhone in very close 

proximity to a subject, you’ll automatically 

trigger the Macro shooting mode. This enables 

you to capture a Raw format file that will have 

a natural blurred bokeh background. 

 
JARGON BUSTER

The f–stop is the width of 
the camera’s aperture (or 
its aperture value). A 
narrow aperture value of 
f14 ensures that 
everything is in focus. A 
wide f–stop of f1.8 will 
produce a strong 
background blur.

 
GENIUS TIP

RAW v JPEG
By shooting bokeh 
naturally using the Photo 
shooting mode, you can 
capture images in raw 
DNG format. Portrait mode 
only lets you capture 
lower–quality JPEG files. 

Shoot Portrait mode 
In the Camera app, swipe to Portrait. 

Compose the shot. Rectangular yellow 

selection markers indicate people and pets. 

The selected subjects will stay sharp while the 

background will be blurred. 

Adjust f–stop 
To adjust the background blur before 

you snap a shot, tap the “f” (f–stop) icon. Use 

the Depth slider to choose a narrow aperture 

such as f14 where everything is sharp. Or 

a wide blur–inducing aperture such as f1.4.

How to do anything on your Mac, iPhone & iPad
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IT’S GOOD TO talk, and it’s 
particularly good when you 
do it with your Watch. 
Whether you’re sending a 

quick update, a heartfelt apology or even 
your actual heartbeat, there are lots of 
ways to communicate. 

And with the Watch Series 7 it’s even 
more useful than before; the new 
Keyboard makes it easy to type letters or 
swipe entire words. Sadly it’s not 
available for older watches because their 

Send messages on  Watch
Staying in touch has never been easier, even when you’re out and about

screens don’t have enough room. Don’t 
worry, though — the standard Scribble 
input method works really well too.
In this tutorial we’ll look at three key 
ways to create messages on your Watch: 
text–only messages, messages with 
additional fun options and quick replies to 
incoming messages too. We’ll also include 
dictating to Siri for those occasions when 
you need to reply but it’s not safe to type, 
such as when you’re driving or cycling.  
CARRIE MARSHALL

REQUIRES
Apple Watch, watchOS 8

YOU WILL LEARN
The best ways to  

send messages

IT WILL TAKE
5 minutes

HOW TO Send a message on  Watch

watch

OS

Say it to Siri
It’s not always convenient to type 

or scribble on your Watch screen, but 

you can dictate to Siri instead. Simply 

raise your wrist (or press the Digital 

Crown if “Hey Siri” is disabled) and say 

“Send [person’s name] a message”.

Say what you want
If the person’s name is recognized 

Siri will ask what you want to say. Dictate 

your message, including any punctuation, 

and it’ll appear on your Watch as you say 

it. When you’re done you can choose to 

cancel or let Siri send it.

Open Messages
If it’s okay to use your Watch, you 

can create a new message by pressing 

the Digital Crown to go into the app 

view and then tapping Messages. 

You should now see a big blue New 

Message button at the top of the screen.
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Pick the person
Tap on the “+” sign next to Add 

Contact to pick a name from your 

contacts. In this example, we’re sending 

to a single person but you can send the 

same message to multiple people too. 

Tap Create Message.

Change your mind
To edit your text, you can tap on 

the Delete icon, the little arrowed box 

with an “X” in it, or you can use the 

Digital Crown. Roll the Digital Crown 

anti–clockwise to move the cursor 

backwards; clockwise moves it forwards.

Add some fun
Tap the App Store icon next 

to the iMessage field to see additional 

options; the faces are Memoji, the 

soundwave is for an audio clip and the 

heart is for sending a drawing or 

heartbeat. We’ll tap the heart…

Pick your method
If you have the Watch Series 7, 

you’ll see a little up arrow at the bottom 

of your screen. Swipe up and you can 

choose between Scribble, the standard 

way to input Watch text, and Keyboard. 

Earlier models don’t have this option.

Make your edit
Tapping the up arrow switches 

between upper and lower case. You can 

also add numbers or punctuation by 

tapping the 123 icon and using the Digital 

Crown to scroll the cursor to where you 

want to put it. Tap ABC to return.

Show, don’t say
You can now draw on the screen 

and add your drawing to your message. 

If you’d rather send your heartbeat, tap 

and hold two fingers on the display. You 

should now feel haptic feedback and see 

the screen red under your fingertips.

Reply really fast
If you’re replying to a message, 

you don’t need to type anything! Scroll 

down to see a collection of predefined 

replies that you can send with a single 

tap. If you’d rather do things manually, 

just tap on the iMessage field.

Grab a GIF
The looking glass enables you 

to send a GIF animation from a large 

collection. Just tap the image you’d like 

to see properly and then select OK 

to add it to your message or Cancel if 

it’s not quite what you’re looking for.

Enter your text
In Scribble, you draw the letters 

on screen but, with Keyboard, draw the 

shapes of the words, so for example to 

type “hey” you’d tap on “h”, slide to “e” 

and then slide to “y”, in one movement. 

It takes getting used to but it’s fast.
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First–time setup
Once Noir is installed, open Safari and 

tap the puzzle icon on a new tab, then Manage 

Extensions. Enable Noir and tap Done. Tap the 

puzzle icon again, tap Noir, then Always Allow 

and “Always Allow on Every Website”.

When should Noir run?
Open the Noir app and tap Settings. At 

the top of the window, you can decide if Noir is 

either always enabled or always disabled 

(regardless of iOS Dark Mode), or whether it 

only runs when iOS’s Dark Mode is active.

 
GENIUS TIP

Under Noir’s More tab, you 
can enable Sync Website 

Settings using iCloud. This 
means there’s no need to 

repeat yourself on each 
individual device.

HOW TO Save your eyes with Noir

MANY WEBSITES HAVE dark 
modes on iOS to shield your 
eyes when you use Safari in the 
evening. Yet even big sites like 

Wikipedia fall short here — open a site 
that lacks a dark mode and you’ll blast 
your eyes with shining white light. 
Luckily, Noir can help. 

This app automatically adds a dark 
mode to any website that lacks it — 
preserving the site’s aesthetic while it 
does so — making evening browsing 
a much more pleasant experience. Noir is 
not just a one–trick pony. It is highly 

Go dark with Noir
Add a dark mode to every website in Safari without lifting a finger

customizable, letting you change the color 
scheme it uses, whether it dims images, 
and more. You can exclude certain 
websites and integrate it into the 
Shortcuts app. That makes it a handy tool 
that can be tweaked however you like.

Additionally, there are no recurring 
subscriptions or in–app purchases to pay, 
just a very reasonable one–off price of 
$2.99. Setup is easy too; just enable the 
Safari extension and you’re good to go. 
Once that’s done, you’ll forget you’re 
even using Noir — it’s that seamless. 
ALEX BLAKE

REQUIRES
Noir $2.99,  

iOS 15 or later

YOU WILL LEARN
How to use Noir to 
automatically turn 

websites dark in Safari

IT WILL TAKE
5 minutes
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Change color scheme
Below this, tap Dark next to Theme to 

change Noir’s active color scheme. There are 

three options to choose from: Dark, Black or 

Gray. Open Safari to see the results (you might 

need to refresh the page each time).

Site–specific rules
To configure settings for the current 

website, tap the puzzle icon in Safari, then tap 

Noir. Under Enabled, you can switch between 

Default, Auto (which syncs with the iOS Dark 

Mode setting), always on or always off.

Noir shortcuts
Noir works well with the Shortcuts app. 

You can toggle the default Noir status, define 

the Noir status for the website you’re on, 

enable or disable image dimming, and set 

image dimming for the current website.

Dim images
Next on the Settings tab is a toggle to 

dim images when Noir is running. This 

prevents nasty surprises when you come 

across a bright picture. Tap Advanced Settings 

to adjust the amount Noir dims each image.

Temporarily disable
Open Safari’s Extensions menu and tap 

Disable Until Tomorrow to temporarily turn 

Noir off for the website you are browsing. If 

you change your mind, open the Safari menu 

again and tap Re–Enable Now to go back.

Create a shortcut
Add a new shortcut in the Shortcuts 

app, tap Add Action, then search for Noir. Tap 

Set Default Noir Status and change Status to 

Ask Each Time. Now you can trigger this 

shortcut to toggle Noir on or off using Siri.

 
JARGON BUSTER

Dark Mode is an iOS 
feature that darkens 
system windows, menus, 
and more. It can do this 
automatically at certain 
times or you can manually 
toggle it.

 
GENIUS TIP

For more consistency, 
open Noir and tap 
Advanced Settings > 
Ignore Site’s Dark Mode to 
use Noir’s theme instead 
of a website’s own dark 
mode version.

How to do anything on your Mac, iPhone & iPad
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THE RUMOURS 

SURROUNDING Apple’s 
launch of a virtual reality 
headset are going crazy at 

the moment — and, right in the middle of 
writing this, news broke that references 
to a new “realityOS” had been found 
hidden in the depths of the App Store.

There are now so many rumours 
swirling around that it’s worth pointing 
out that there are actually two virtual 
reality devices thought to be in 
development at Apple. The one that’s 
getting everyone in a complete frenzy at 
the moment is a proper headset — 
something along the lines of Facebook’s 
Oculus headset — that wraps right around 
the wearer’s head, completely covering 
your eyes with a pair of built–in screens. 
This headset is making headlines at the 
moment as it’s expected to launch either 
this year or early in 2023. And, with the 
launch date so near, the cloud of rumours 
is starting to focus on some common 
factors that indicate the new headset will 
pack some serious high–end technology. 

It now seems likely that the Apple 
headset will include a pair of 8K displays 
(one for each eye) with a resolution of 

Mixed reality and Apple Glasses
It will be Apple’s biggest launch in years. What’s behind the Apple headset?

7680x4320. These displays will also be 
powered by the same M1 chip used in the 
24–inch iMac, Mac mini, and MacBook 
Air. However, the industry analyst 
Ming–Chi Kuo — who has a pretty good 
record with Apple predictions — has 
predicted that the headset might actually 
use two M1 processors for extra power, 
while others have suggested that it could 
use the even more powerful M1 Pro or Max 
(which would be kind of awesome). It’s 
likely that the headset will include a 
variety of sensors for tracking the 
movement of your head and your eyes 
while wearing it, but it’s also been 
suggested that the headset may be able to 
track the movement of hands and fingers 
as well, so that you can interact with the 
virtual world that you see on the display. 

Estimates about the price of the 
headset are less clear, though. Some 
rumours put it as high as $3,000, which 
would very much position the headset as a 
tool for power users in fields such as 3D 
graphics or engineering, who can also 
afford the high–end Mac Studio. Other 
estimates say that the price could be as 
low as $1,000, which would make it much 
more of a consumer–oriented device, for 

YOU WILL LEARN
About the technology 

behind Apple’s MR 
headset, and its future 

applications

HOW IT 
WORKS

Image rights: Hewlett Parkard.

A headset is 
sometimes called an 
HMD — head mounted 
device — as it covers 
the user’s entire head.

KEY FACT

There are two types of VR 
headset currently 

available. Some headsets 
have good displays, but 

they don’t have their own 
CPU to control them. This 

means that the headset 
has to be connected to a 

PC or games console at all 
times. However, the use of 
Apple’s M1 chip could allow 

its headset to work on its 
own, without needing a 

Mac, iPhone or iPad.

THE MOST 

IMPORTANT 

FACTOR IS 

REALLY 

APPLE’S 

VISION FOR 

HOW THIS 

HEADSET 

COULD BE 

USED
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games, video and other forms of 
entertainment. However, it’s hard to see 
how a headset that contains two 8K 
displays and two M1 chips could be 
produced for that kind of price, let alone 
sold at a profit.

THE VISION THING

So what is Apple’s vision for how this 
headset could be used? Sometimes 
referred to as an “AR headset” 
(augmented reality) or a “VR headset” 
(virtual reality), it now seems that the 
rumour mill is settling on the term “MR” 
or “mixed reality”, which really just 
means that the headset will be able to 
switch between AR and VR for tasks.

Apple has long been interested in AR, 
which combines the real world that we 
see around us with digital info of some 
kind. The cameras used in early iPhone 
models helped to create an interest in AR, 
with some early AR apps that could 
examine the buildings or location around 
you, and then superimpose helpful 
information on the screen about 
restaurants, hotels, or tourist spots. 

However, it was the arrival of Pokémon 
Go in 2016 that really put AR on the map, 
displaying the real–world scene around 
you with the addition of a cute computer–
generated Pokémon that you could go 
chasing after. Apple launched its ARKit 
programming system the following year 
as part of iOS 11, and there are now many 

AR apps that enable you to experiment 
with decorating your home by placing 
computer–generated images of furniture 
on the screen of your iPhone or iPad, or 
checking out a new pair of glasses 
superimposed over your face. Engineering 
and design is an important area for AR 
too, enabling engineers and architects to 
add computer–generated imagery of new 
buildings and structures to the scene 
around them. And, of course, there are AR 
games aplenty, with Pokémon still going 
strong and an updated version of Angry 
Birds that lets you chuck the little 
feathered critters around your own home.

Virtual reality is different. Most modern 
computer games with 3D graphics, such 
as World Of Warcraft, exist in their own 
VR world that is self–contained and 
entirely separate from the “real” world. 
Apple has never shown much interest in 
VR — it’s never been very interested in 
gaming, and VR was often simply thought 
of as a form of gaming tech. Of course, the 
headlines these days are full of the 
“metaverse”, which goes beyond gaming 
to create a wider digital universe that 
encompasses business, entertainment, 
and social media. That’s why Facebook is 
so interested in the metaverse, and also 
the reason why Apple needs to show that 
it has its own vision for AR/VR, in order 
to prevent Mark Zuckerberg from 
crowning himself King Of The Metaverse. 
CLIFF JOSEPH

Image rights: Snap Inc.

> THROUGH THE LOOKING GLASS

KEY FACT

Facebook’s current Oculus 
Quest 2 is relatively 
affordable, with prices 
starting at just $299. 
However, its twin displays 
only have a resolution of 
1832x1920 for each eye. 
That’s far lower than the 
8K displays (7680x4320) 
we expect to see in 
Apple’s headset, and 
Apple’s M1 processor 
should give it a bit more 
horsepower for high–end 
graphics too.

And then there’s the other VR product… 

The MR headset we’ve focused on here is 

likely to arrive towards the end of 2022 

but, looking further ahead, it’s also 

thought that Apple is developing a set of 

Apple Glasses as well. The Apple Glasses 

are expected to be more like the ill–fated 

Google Glass, which had a brief moment 

of fame — or infamy — almost a decade 

ago (and resulted in the wearers being 

dubbed “Glassholes”). 

The Apple Glasses will be more like a 

conventional pair of sunglasses or 

reading glasses, allowing you to see 

through the lenses, and also to retain full 

peripheral vision so that you can still see 

what’s going on. However, the lenses will 

also be able to display computer 

graphics and other information, in order 

to create an “augmented reality” that 

enhances the world you can see around 

you. But shrinking a full–size headset 

down to the size of a small set of glasses 

is no easy task, and it’s unlikely that the 

Apple Glasses will be launched before 

2025 or even later.

Apple’s VR device should look more like a 
conventional pair of glasses, like these 
Spectacles by Snap.
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